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Chapter 1Chapter 1Chapter 1Chapter 1     

 

Introduction 

 

 

Welcome to Geomatica LidarEngine, a high performance data management, 

analysis, and visualization tool for LiDAR (Light Detection and Ranging) data. 

 

Geomatica LidarEngine allows for rapid, accurate Lidar data point handling and 

surface generation providing DEM information for ortho generation and other 

analytical processes.  It offers a complete set of spatial analysis tools that are 

leveraged by a next generation GIS with exceptional power, speed and ease-of-

use. 

 

Power.  Geomatica LidarEngine gives users the power to perform advanced 

spatial analysis with a vast library of functions.  These functions are built on robust 

and state-of-the-art .NET architecture.  The strength of the platform is evident as 

Geomatica LidarEngine allows its users to create, view and process large raster 

files with no limitations on size. 

   

Speed.  Geomatica LidarEngine is fast, and users will notice screen refresh as they 

manipulate large 2D and 3D raster files real time.  Running multiple functions 

simultaneously with Geomatica LidarEngine’s multi-threaded architecture, means 

getting results faster than ever. 

 

Ease-of-use.  Geomatica LidarEngine was designed with the user in mind.  It 

features drag and drop, point and click functionality, along with wizard driven 

work flows and preview windows, all packaged within an easy to use project-style 

dashboard environment. 

 

PCI Geomatics is a world-leading developer of image-centric software and 

solutions for the geospatial industry.  We understand that as a geospatial software 

professional, your job is to get the most out of your data, extracting information to 

help make better decisions about your world.  With Geomatica LidarEngine we 

are providing you with the best tools available to help turn spatial data into 

information.   
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About Geomatica LidarEngine 

 

PCI Geomatics is an industry leader in providing accurate, efficient and 

affordable geospatial solutions.  Geomatica LidarEngine is a robust data 

management, analysis and visualization tool for processing and analyzing LiDAR 

data.  LidarEngine’s architecture and algorithms are well suited for processing the 

very large volumes of LiDAR data. 

 

With fast processing of LiDAR point data to generate a 3D digital elevation model 

surface, impressive 3D visualization, exceptional data analysis, and ease of use – 

Geomatica LidarEngine is a unique approach to spatial information technology. 

 

With Geomatica LidarEngine making accurate location-sensitive decisions is 

faster and easier than ever before! 

 

 

Using this documentation 

It is assumed that you are familiar with the Windows environment.  You 

should be used to opening, closing and resizing windows, access 

menus, expand and collapse folder trees, and copying and pasting 

information from one location to another. 

 

 

Getting help 

You can access the online help documents by selecting the Help 

menu and then choosing the Online Help menu item. You can access 

help directly from any dialogue by pressing the F1 key.  When Help is 

accessed in this manner you are taken directly to the appropriate 

location within the help file without having to search.  

 

Getting Technical Support 

For technical support and licensing we can be reached by phone, 

fax, or email. Hours of operation are 8.30 am to 5:30 pm Eastern 

Standard Time, Monday to Friday (Selected Holidays excepted).  



 

Geomatica LidarEngine User Guide                                                                                           9  

When contacting support please remember to:   

1) Check the Software Updates to ensure that you have the latest 

fixes and updates   (license requests excluded).  

2) Include (or have ready) your customer number, company name, 

your name (and primary contact if you are not one, operating system 

and version, software version, program, etc.) 

3) Include a detailed description of the problem, data set being used, 

and steps needed to reproduce the problem. You can include any 

screen grab that would be helpful and attach or ftp the file in 

question. The more information that you can provide us, the faster we 

can resolve the problem.  

Email: support@pcigeomatics.com 

 

Web:  http://www.pcigeomatics.com/services/support_center/contact_support.php 

 

Phone: Toll Free (North America) 1-877-RING-PCI (1-877-746-4724) 

 

Fax: 1-905-764-9604 (Attention Support) 

 

FTP Instructions:  

� ftp: ftp.pcigeomatics.com  

� login: anonymous  

� password: email address  

� upload files to: /pub/incoming  

email support@pcigeomatics.com with the exact file name (note: you 

can not view the content of /pub/incoming). 
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Installation Guide 

In this section you will be provided the step by step instructions to installing and 

launching Geomatica LidarEngine.  Once Geomatica LidarEngine is installed, get 

a quick run through of some of its capabilities from the Quick Start Tutorial in 

Chapter 2. 

System requirements 

The following list contains the recommended system requirements for 

Geomatica LidarEngine.  In addition to these, Geomatica LidarEngine 

also requires that your computer system have the .NET Framework 

and Microsoft Direct X installed.  If you are unsure if your system has 

these components you can install them from the Geomatica 

LidarEngine installation CD.  

• Microsoft Windows XP (Professional or Home Edition) with 

Service Pack 1 or Service Pack 2, or Microsoft Windows 2000 

with Service Pack 4 

• 2 GHz processor 

• 512 RAM 

• 1024 x 768 with true color 

• 100 MB of hard disk space (NTFS file system is recommended) 

• 64 MB video card 

• MS-Mouse compliant pointing device with scroll wheel 

• CD ROM 

 

Installing Geomatica LidarEngine 

Installing Geomatica LidarEngine is no different than installing other 

software products.  The installation wizard guides you through the nine 

step process that will only take a few minutes to complete. 

We recommend that you exit from other programs before beginning 

the installation process. 

1. Place the Geomatica LidarEngine CD in the CD-ROM drive in 

your computer. 

2. Run the Geomatica LidarEngine Setup.exe file.  
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3. Welcome page - click Next. 

4. License agreement - either accept or decline the license 

agreement.  If you choose to decline the agreement click the 

Cancel button to exit.  To continue with the installation choose 

the “I accept the agreement” option and click the Next 

button. 

5. Install location - choose where you would like Geomatica 

LidarEngine to be installed.  By default it will be installed into 

the Program Files folder on your computer system.  Click the 

Browse button if you wish to have it in another location. Click 

Next to continue. 

6. Shortcut location - choose where the Geomatica LidarEngine 

shortcut will be placed in your computer’s Start Menu folder.  

By default the folder name will be called “Geomatica 

LidarEngine” and will be located at the main folder level.  

Select the Browse button if you wish to choose a different 

location.  Click Next to continue. 

7. Desktop icon - choose whether you would like to have a 

shortcut placed on your desktop. Click Next to continue. 

8. Summary - the summary page will appear next.  It summarizes 

all of the installation choices you have made.  Click the Back 

button to make changes to these options or click Install to 

proceed with the installation. 

9. Other Components - after Geomatica LidarEngine has been 

installed on your computer you will be given the choice to 

install other required third party components.  These 

components are the Microsoft .NET Framework and DirectX 

9.0.  If you are unsure if these components are already 

installed please choose to install them just to be certain.  If 

newer versions are found on your computer, then the ones 

provided will not be installed.  Click the Finish button 

 

Launching Geomatica LidarEngine 

In general, launching Geomatica LidarEngine is performed by either 

selecting the Geomatica LidarEngine program link located in your 

computers Start Menu folder or the icon located on your desktop.  

The desktop icon will only be present if you chose to create it during 

the installation procedure. 
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If you checked the “Launch Geomatica LidarEngine” option located 

on the last step of the installation wizard then Geomatica LidarEngine 

will automatically be initiated.  You should immediately see the 

Geomatica LidarEngine splash screen and the progress of it loading 

into memory. 

If you are starting Geomatica LidarEngine for the first time then you 

will be asked for some information related to licensing prior to 

opening the main application window.  Please see the Product 

Licensing section for details. 

Product Licensing 

The licensing mechanism for Geomatica LidarEngine is initiated when 

the product is first launched.   Nothing is required to install the product 

other than the installation CD itself.  When the software is launched for 

the first time the AmberCore Licensing dialog will appear as shown 

below.   

 

 

It is from this dialog that you will specify which licensing mode the 

software will be run under, either evaluation or registered mode. 

Please note that in order for the license retrieval system to work 

automatically an internet connection is required. 
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Evaluation Mode 

As previously mentioned if you are evaluating the software you will 

not need a License Key to install and run the product.  When the 

AmberCore Licensing dialog appears, simply choose the evaluation 

option, complete the customer profile and click the Activate button.  

The software will then contact the AmberCore license server and 

retrieve an evaluation license key and upload it to your system.  This 

key will allow the software to operate in its entirety for a 30 day period 

beginning from the day the license was retrieved.  You will be notified 

each time the product launched to how many days remain in the 

evaluation. 

If you do not have an internet connection, please see the section on 

Manual License Retrieval. 

Registered Mode 

If you have purchased Geomatica LidarEngine, you will want to 

choose the Registration option on the AmberCore Licensing dialog.  

When this option is chosen you will be prompted to enter the 26 

character installation key that was issued at the time of purchase.  If 

you have not received this key please contact your reseller 

immediately.  Next, complete the customer profile section and click 

the Activate button. The software will then contact the AmberCore 

license server and retrieve a digitally signed license key and upload it 

to your system.  This key will allow the software to operate indefinitely. 

If you do not have an internet connection, please see the Manual 

License Retrieval section. 

Manual License Retrieval 

If you do not have an internet connection or you encounter network 

issues that prevent you from connecting to the AmberCore license 

server you will receive a notification like the one below. 
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This dialog will appear whether you are evaluating or registering the 

software.  At this point you have three options.  You can solve your 

connection problem and click the “Try again” button, you can click 

the “E-mail AmberCore” button to initiate the manual license retrieval 

process, or you can click the “Use temporary license” button to use 

the software without a license key. 

If you are unable to correct your network problem then follow the 

simple two step process to retrieve your license manually.   

1. Contact AmberCore Software by email and provide us your 

Geomatica_LidarEngine.dlsc file as an attachment to the 

message.  The easiest way to do this is to click the “E-mail 

AmberCore” button located on the AmberCore Licensing 

dialog.  This will open a new email message window with the 

proper address and file attachment.  All you have to do is 

send it to us. 

If this new message window fails to open then send the 

license file to licensing@ambercore.com. The license file is 

located in the folder which the program was installed, 

typically this is C:\program files\Geomatica LidarEngine\bin\. 

 

2. In a short period of time you will receive back an email 

message with a digitally signed license key as an attachment.  

It is this key that will allow the software to operate within the 

bounds of the license type.  Save the attachment to the 

C:\program files\Geomatica LidarEngine\bin\ folder on your 

computer system. 
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While you are waiting for your digitally signed license key to arrive you 

may use the software for a limited period of time.  This is done by 

clicking the “Use temporary license” button on the AmberCore 

Licensing dialog.  If you are evaluating the software then this grace 

period is set to 2 hours, if you are registering then it is 72 hours.   

Each time the software is launched and a digitally signed license key 

is not found you will be given the opportunity to retry connecting  

Accessing your license information 

You can access you license information by selecting the Help > 

Software Licensing menu item from the main menu inside of 

Geomatica LidarEngine.  When this menu item is selected the 

AmberCore Licensing dialog will appear.  It is from this dialog that you 

can obtain information such as the license key that the product was 

registered under, the user profile that was initially entered, and the 

license type.  Also available is a listing of product components that 

the license covers.  Each component is given a date stamp to help 

identify its versioning.   

Refreshing your license 

The AmberCore licensing system uses the configuration of you 

computer system to generate the license key.  Any changes to this 

configuration may disable the software.  If this occurs then you will 

have to contact AmberCore to initiate a license refresh.  When you 

are instructed to do so, open the License Information dialog by 

selecting the Help > Software Licensing menu item.  When the 

AmberCore Licensing dialog appears, click the Register button 

located on the bottom of the dialog. 

Uninstalling 

Select the Uninstall link located in the Geomatica LidarEngine folder 

under the Start Menu. You can also uninstall the product using the 

Control Panel. 

 

 

 

 



 

16                                                            Geomatica LidarEngine User Guide 

Quick Start 

This leads you through the steps in Geomatica LidarEngine to: 

• create a new project 

• load LiDAR point files into the project 

• use the Project Manager 

• build a surface from the points 

• display the surface and points in 2D 

• display the surface and points in 3D 

• navigate the 3D scene 

 

You will need a file containing XYZ point data, either: 

• file(s) with extension .las containing LiDAR point data 

• or ascii file(s) with x or y or z in their extension and having X Y and Z 

contained in 3 of the columns 

 

 

Create a New Project 

The combination of all your map layers makes up your project.  The project is 

designed to help you have easy access to your data and to keep your map files 

organized. 

� Open the New Project Wizard using the menu bar at the top left. 

>File>New Project>New 

� Enter Project Name and Location 

e.g. Project1   c:\GeomaticaLidarEngineProjects 

Click Next 

Click Finish 
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Load LiDAR point files into the project 

Load xyz point data either from .las extension LiDAR files or from any ascii files 

containing columns of xyz coordinates. 

� Open the Lidar Processor Wizard using the menu bar at the top left. 

>Workbench>Lidar Tools>Lidar Processor 

Choose External Files and Browse 

 

� Choose Files of Type .las or .*x*y*z* 

 

.las extension files contain LiDAR point data 

 

.*x*y*z files with x or y or z in their extension 

are assumed to be ascii files having 

X Y and Z coordinates in the first 3 

columns 

 

Select one or more files and then  

the >> button 

 

 

� Uncheck Merge Layers into one 

Check Save feature layers into project as 

Check Multi-points 

Check Build index for fast display 

Uncheck Build surface 

Click Finish 

 

The files are loaded into the directory called 

LiDAR feature layers 
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Use the Project Manager 

The Project Manager window is opened and closed using the menus at the top 

left of the screen: 

� Open the Project Manager using the menu bar at the top left 

>View>Project Manager 

� New folders are created by right clicking in the Project Manager window 

Right click > New Folder 

� Files can be moved between folders by simply dragging them 

� Folders or files are removed by right clicking them in the Project Manager 

Right click > Remove from project 

 

 

 

 

Build a Surface from the Points 

� Open the Lidar Processor Wizard using 

the menu bar at the top left. 

>Workbench>Lidar Tools>Lidar Processor 

Choose Project and select the files 

which you previously loaded 

Then press the >> button 
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� Check Save feature layers into project as 

Check Multi-points 

Check Build index for fast display 

Check Merge Layers into one 

Check Build surface 

Click Finish 

� Change the Cell Size to round it off or else go 

with the default 

� If your data set has Intensity values after the XYZ 

coordinate data then: 

Check the box called Create Intensity Layer as 

Check Image 

Select an Intensity Range from 0 to 200 

(If the intensity map produces a black image 

then you may have to repeat this process using 

a smaller range such as 0 to 30) 

� Leave other options as the default 

(Explanations appear in the Lidar Tools Chapter) 

 

 

 

 

 

 

 

 

Three files are produced: 

A file containing all the Points merged together 

A file containing the created Surface 

A file containing the Intensity (where applicable) 
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Display the Surface and Points in 2D 

� Open the Layer List window using the menu bar at the top left 

>View>Layer List 

� Double click the surface layer file in the Project Manager window to open 

a map window in 2D 

� Use the Shading button to switch on Hill Shading 

� Use the Zoom and Pan buttons to 

navigate the map in 2D 

      

� Drag the Point file onto the open 

Surface layer to display points on top 

� Make the point layer transparent by 

highlighting the Point file in the Layer 

List and then using the sliding bar on 

the bottom right 

Display the Surface and Points in 3D 

� Use the 3D button to view the layers in 3D 

� Drape the Point layer over the Surface layer using the Drape button  
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If you have an intensity map you can drag this on top of the map, drape it in 3D and make 
it semi transparent also. 
 
Layers can be switched on and off using the Layer List. 
 
 

 

 

Navigate the 3D scene 

 

Change the perspective in the 3D view using the following tools: 

� Rotate horizontally –  Click inside window and drag your cursor to the left 

and right 

� Rotate vertically – Click inside window and drag your cursor up and down. 

� Zoom-in / out – Hold down the Control key and roll the mouse wheel back 

and forth. 

� Panning – Hold down the Shift key while clicking and dragging your cursor 

in the window.  This can also be achieved by selecting the Pan button 

from the toolbar inside the 3D window. 

� Vertical exaggeration – Roll the mouse wheel back and forth. 
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Chapter Chapter Chapter Chapter 2222    
 

LiDAR TOOLS 

 
 

 

 

Overview 
 

The LiDAR Processor wizard makes the process of surface generation 

based on input LiDAR points easy to follow by guiding the user through 

the successive steps.  The wizard allows the operator to load one or more 

input point data layers and build them into a Digital Elevation Model 

surface.   

 

The Feature Merger Wizard is required when the user needs to merge 

several vector data layers into one layer in the currently opened project.  

For example, it may be necessary to combine several LiDAR point layers 

into one for the purpose of analysis. 

 

• LiDAR Processor 

• Feature Merger 
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LiDAR Processor 

The wizard consists of several steps: 

 

Step 1 – Data Input 

 

In this step, input point data is selected for processing.  The data can be selected 

from: 

- the external disc / network drive (“External files”) 

- the currently open LidarEngine project (“Current project layers”) 

 

When selecting from the external files you can select several files simultaneously. 

However only one file type is allowed to be processed in each wizard session (i.e. 

all the files must have the same extension: either *.las, *.isd or *.xyz). 

 

Selecting from the project structure allows you to navigate though the project 

tree selecting multiple point layers to be used by the wizard as inputs. 

 

Additional Step for Text Data 

 

If text based data from external file was selected, then an extra step will allow 

you to view the data structure and specify its usage. If several data sets were 

selected, then it is assumed that all of them have the same structure based on 

the structure of the first one. Datasets with the different structure will be ignored 

while processing. 

 

Step 2 – Data Output 

 

Step 2 allows the operator to define what output results will be produced and to 

specify the location for it. There are two groups of settings. 

 

The first group of settings defines what will be built. The settings are: 

 

• “Merge layers into one” option allows all input layers will be merged into 

one. Checking this box also enables the ability to have the resulting 

merged point data saved in the project.  If this option is not selected then 

the wizard will generate several surface layers corresponding to each 

input point data set. 

 

• “Multi-Points” format option should be chosen to ensure the fastest build 
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• “Points” format option should only be chosen if you wish to use the Point 

Aggregation or Point Collocation features 

 

• “Build pyramid for fast display” option is preferable and allows fast zoom 

in/out display operation when viewing large point data layers (millions 

points). However it takes some additional time to build. 

 

• “Build Surface” option causes a surface to be generated.  By un-checking 

the “Build Surface” option, the output of the wizard will simply be the point 

layer (or layers) saved into the project structure. 

 

The second group of settings allows projection of the output layers to be defined. 

 

This projection can either be selected from the drop-down list of projections taken 

from the input layers or can be defined explicitly. The user should be aware that  

• in the case of several input projections, the resulting surface building time 

will increase significantly, 

• in the case that all input layers have no projection defined, it is not 

possible to define it during this wizard process and (if needed) the 

projection will have to be explicitly assigned to the output result later. 

 

Step 3 – Surface Building Parameters 

 

This step defines what parameters should be used for the surface building. The 

parameters are: 

 

• “Cell size” (resolution) - This parameter defines the size of resulting grid cell 

in meters. It is initially set to default value based on the input data analysis 

(Roughly it is calculated as the square root of the space of entire area 

divided by the number of measurements). 

 

• “Interpolation radius” – The algorithm uses this proximity radius around 

each grid cell to search for points.  The cell value is then calculated 

based on the chosen interpolation method using all the measurements 

found within the proximity radius. 

 

• “Interpolation mode” – Could have one of the following values: 

 

- Nearest neighbor – The interpolated value is taken from the 

nearest measurement (within the proximity) or from the nearest 

grid cell (for the fill gaps mode). 

- Normal Core – The interpolated value is calculated as the average 

within the radius using the normal core distribution method of  

weight estimation. 
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- Square distance – Same as Normal Core but the weight is inversely 

proportional to the square of the distance. 

- Normal Core Smooth or Square Distance Smooth – Are 

recommended to use for relatively smooth terrain surfaces and are 

not recommended for example for urban areas.  

 

• “Display style” – Can have one of two values: 

 

- Flat – Will display squares with the same color for each cell. 

- Smooth – Will interpolate colors between cell points, thus avoiding 

displaying squares while zooming in. 

 

• “Fill breaches” - All grid gaps having a width less than this specified value 

will be filled with values from cells within this radius having been 

interpolated using selected method. This is used for filling small breaches 

and usually takes place in case of poor data with missing measurement 

points. 

 

• “Intensity” – This option allows the saving of an intensity layer based on 

interpolated results as: 

- Grid – Use this option if you intend to perform analytical operations 

on result using other application wizards. 

- Image – Use this option if you are interested in simply building and 

viewing the image draped over the DEM. 

 

• “Min-Max” – Set these values to define the intensity range where input 

data intensity is mostly allocated. 

 

• “Gap filling” – is used to fill gaps for areas that were not scanned or have 

missing data. Is also used for instance to reconstruct the water surface 

where LiDAR data is usually not available. 
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Feature Merger Wizard 

 

The wizard consists of three steps. 

 

Step 1 – Data Output 

 

This is the standard step allowing the user to specify an output folder for the 

resulting merged layer. Simply select an existing project folder or confirm the 

default one offered by the wizard. 

 

Step 2 – Data Input 

 

This step allows the user to select several input layers that have to be merged into 

one.  It shows the project structure and allows multiple file selection (clicking on 

the folder check box selects all underlying layers).  

 

The user can combine either several layers having projections already defined or 

else several layers having no projections yet defined.  A mixture of some defined 

and some not defined is not allowed. 

 

Note that if layers are to be merged from several different projections, then the 

user should be aware that re-projecting operation may considerably slow the 

merge process. 

 

It is also the user’s responsibility to make sure that selected layers are covering 

same approximate geographical location to be viewed together after the 

merging. 

 

Step 3 – Default 

 

By default it is assumed that the files being merged have the same data type 

(e.g. several point layers) and that they have the same attribute table columns.  If 

this is the case then simply proceed past this step and merge the layers. 

 

Step 3 – (Advanced Options) 

 

If the files being merged have different data types (e.g. point and lines) or if they 

have different attribute table columns, then step 3 gives the flexibility to 

advanced users to define separate sub layers within the structure of the resulting 

merged layer. 
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The advanced user can create output sub-layers and then group data into each 

sub-layer: 

• Add or Remove output sub-layers in the data structure, 

• Rename output sub-layers, 

• Assign each of the merged layers to a sub-layer 

 

The advanced user can combine and merge attribute columns of the merged 

layers: 

• Combine all columns – The number of columns in the resulting layer will 

equal the sum of all columns in the input layers (e.g. L1 has columns A,B 

and L2 has columns B,C. The resulting layer will have columns A,B,B1,C). 

• Merge all columns – will look for the same name/type input columns in 

selected input layers creating one output column for all of them in the 

output layer (e.g. L1 has columns A,B and L2 has columns B,C.  The 

resulting layer will have columns A,B,C). 

• Merge only same columns – will create the number of columns in the 

resulting layer as the intersection of the input layers columns (e.g. L1 has 

columns A,B and L2 has columns B,C.  The resulting layer will have only 

column B). 

 

The user can also select which of the input layers will define the output projection. 
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Chapter Chapter Chapter Chapter 3333    

 

Interface 

 

Overview 
In the last chapter you had quick introduction to many of the 

interface features that allow you to manage your working 

area, create maps, and query data.  This chapter is designed 

to expand on what you have already learned by describing in 

more detail how these features work and how they can be 

used. 

 

This chapter covers the following topics. 

 

• Toolbars 

• Panel Windows 

• Geomatica LidarEngine Projects 

• Solvers and Wizards 

• Creating Output 

• Table Window 

• Map Legends 
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Toolbars 

Geomatica LidarEngine includes several toolbars each containing a number of 

buttons that initiate the more common functions in the product.  For example you 

can open and close projects, query information from locations on a map, and 

organize open windows by tiling them. In this section of the User Guide you will be 

given a more thorough understanding of how toolbars behave and what 

functions can be accessed from them.  Where appropriate you will be referred to 

other locations in the guide where you can get more detailed information.  

 

Toolbar Viewing States 

All Geomatica LidarEngine tools have been organized onto several different 

toolbars, they include Main, Output, Window, Map View, 3D, Drawing and Scale.  

Each of these toolbars have four different viewing states or locations where they 

can be placed, docked to the main application window, docked to a map 

window, floating, and turned off. 
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Opening and Closing toolbars 

Toolbars are turned on and off by selecting them from the Toolbar 

menu.  This menu can be accessed in two different ways.  The first is to 

navigate to it by selecting the View > Toolbars menu located the 

main menu bar.  The second way is to place your cursor on the 

toolbar area on the main application window and click the right 

mouse button. 

   

Toolbar list from main menu       Right click menu 

A check appears beside each toolbar name that is open regardless 

of its location.  When a toolbar is opened it will appear in the location 

where it was last closed.  To close a toolbar from view entirely it must 

first be in the floating state, you then must select the close button in 

the upper right corner of the toolbar. 

Docking to Main Application Window 

Docking a tool bar to the main application window can be done in 

two ways depending on which state it is currently in.  If the toolbar is 

docked to the map window then all you have to do is “check” that 

toolbar from the View > Toolbar menu.  If the window is floating then 

you will have to click and drag the toolbar to the top of the screen 

where the tool bars generally reside.  A gray outline will appear when 

toolbar becomes docked.  When a toolbar is docked to the main 

application window its functions apply globally to all open windows or 

files. 

Docking to Map Window 

Docking a toolbar to a map window can only be done one way, 

“unchecking” that toolbar from the View > Toolbar menu.  When this 

is done then all map windows will contain the toolbar docked to the 
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left side of the window.  In general when a toolbar is docked to the 

map window its functions only apply to that window.  

Floating a Toolbar 

To make a toolbar float it first must be docked on the main 

application window.  When it is in this position it can be selected a 

dragged away from the window.  This is done by clicking on the 

toolbar handle and dragging it away.  The toolbar handle is the 

double line that appears on the left side of the toolbar. 

Once the toolbar is floating it can be placed any where on your 

screen, resized and even re-docked to the application window 

Locking and Unlocking a toolbar 

Right click on the tool bar area to get the menu and select the Lock \ 

Unlock option located on the bottom of the menu.  By selecting the 

Lock option the edit handles are removed from all toolbars 

preventing any modifications to them.  Locking toolbars does not 

affect those that are docked to a map window. 

 

Main Toolbar 

The Main toolbar contains functions related to opening, closing and creating 

projects. The default location for this toolbar is on the main application window. 

 

 

 

Open 

Project 

Allows you to open a previously saved project 

from a directory of your choosing.   

 

 

New Project Opens the ‘Project Set-Up’ wizard that will guide 

you through the necessary steps to create a 

new project.  If a project is already open when 

this function is chosen then it is automatically 

closed. 

 

 

Close 

Project 

Closes the current project.   

 

 

Add Map Opens the Add Map dialogue where you can 

select maps to your project.  From this dialogue 

you will have to specify to which project folder 

the selected maps will be saved.   
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Remove 

Map 

Opens the Remove Map dialogue where you 

can choose one or more maps to remove from 

the project. 

 

 

Output Toolbar 

The Printing toolbar contains features that help you get your maps out of 

Geomatica LidarEngine by printing the contents of a map window or saving it to 

an image file.  The default location for this toolbar is on the main application 

window. 

 

 

Print Preview Previews the contents of the current window.    

The preview will help you to visualize what the 

final product will look like. 

 

 

Print Prints the current window to the default printer. 

 

 

Save as 

image 

Saves the view in the current map window to an 

image which can be used in other applications. 

 

Export to 

Google 

Earth 

Saves the current map window as a .KML file 

which can later be viewed in Google Earth™. 

 

Window Toolbar 

The Window toolbar contains features that help you arrange multiple windows 

within Geomatica LidarEngine.  These features only apply to open windows and 

not to windows that have been minimized to the bottom of the application 

window.  The default location for this toolbar is on the main application window. 

 

 

Cascade Arranges all open windows in overlapping and 

cascading fashion with the first one being 

located in the upper left corner of the 

application window. 

 

Tile Arranges all open windows horizontally allowing 
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Horizontally you to see all windows at the same time 

 

Tile Vertically Arranges all open windows vertically. 

 

Map View Toolbar 

The Map View toolbar contains several tools that help you change the view 

perspective of the map.  For example there are tools that allow you to zoom-in 

and out on the map and turn on graticule lines.  Because these tools directly 

relate to the map window the default location is on the map window.  

 

 

Zoom-in Allows you to zoom-in on the map.  Either click 

on the location you wish to see a closer view of 

or click and drag a box around there area you 

wish to see. 

 

Zoom-out Allows you to zoom-out on the map.  Either click 

on the location you wish to zoom-out from or 

click and drag a box around there area you 

wish zoom-out from. 

 

Pan Allows you to click and drag the map to a new 

viewing location. 

 

Zoom Extents  

-Current 

Layer 

Changes the map view so the extents of the 

current map layer fits into the map window.  The 

current map is the highlighted one in the Layer 

List. 

 

Zoom Extents 

- All Layers 

Changes the view of the map window so that 

the extents of all the layers in the window are 

visible. 

 

Zoom Extents Changes the view in the map window so that all 

selected objects are visible. 

 

 

Table 

Window 

Opens the table window of the current map 

layer. 

 

 

Information Allows you to inspect the attribute information 

of map objects located at selected locations 

around the map.  The information is displayed in 

the Information panel window. 

 

Snap Forces the cursor to locate itself at the closest 

node.  Typically used in conjunction with the 
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drawing tools. 

 

Measure A tool used for drawing a measure line on the 

map.  The length of the line is displayed in the 

status bar of the main application window.  

 

Clear 

Measure 

Clears the current measure line so that a new 

one can be created. 

 

Relief 

Shading 

Turns on the relief shading for a grid layer.  This 

feature is available for all numeric grid types but 

is most visually effective of elevation grids. 

 

Colorizer Opens the color tool for the current grid layer. 

 

 

Legend Opens a window adjacent to the map window 

containing the legend of the current map layer.  

The legend of other map layers can be 

displayed by choosing the Legend button 

again. 

 

Set Window 

Projection 

Allows you to manually set the projection of the 

current map window. 

 

Graticule 

Lines 

Turns on and off graticule lines inside the map 

window.  Coordinate readout appears in the 

upper left corner of the map window when the 

cursor is placed on the graticule line. 

 

3D Toolbar 

The 3D toolbar contains tools relating to the 3D view.  From this toolbar a map 

window can be change to a three dimensional view and then the display 

modified using some of the other provided tools. Because these tools directly 

relate to the map window the default location is on the map window.  

 

 

3D View Places the map layers into a three dimensional 

view.  Most effective when an elevation grid is a 

layer in the map window. 

 

Wireframe Changes the display of the current grid in the 

map window to a wire mesh.  Essentially only 

the boundaries of each grid cell are rendered 

and not the entire cell face.  This increases the 
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refresh time, especially in 3D mode. 

 

Collapse 3D 

Layers 

When in 3D mode this feature collapse all layers 

so they are displayed at the same vertical 

location. 

 

Show Extents When in 3D mode this feature turns on or off the 

extents of the map window as displayed in the 

two dimensional view.  

 

Enable 

Markers 

Turns on and off the geographic coordinate 

values which are displayed around the outside 

of the 3D viewing area. 

 

Drape Captures a raster image of all map layers in the 

scene and applies them to the surface of the 

Master grid layer.  

 

3D Cursor Toolbar 

The 3D Cursor toolbar contains tool that allow you to manipulate the cross 

sectional planes in a three dimensional block model. This toolbar is only available 

when a block model layer has been rendered in 3D.  Its default location is in the 

main application window. 

 

 

X-axis Allows you to change the location of the x-axis 

cross sectional plane. 

 

Y-axis Allows you to change the location of the y-axis 

cross sectional plane. 

 

Z-axis Allows you to change the location of the z-axis 

cross sectional plane. 

 

XYZ axis Allows you to modify the location of the cross 

sectional plane for all three axis.  Each axis is 

modified one at a time with each click of the 

mouse button. 
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Drawing Toolbar 

The Drawing toolbar contain features that help you edit the features contained in 

the map window.  For example you can add points, lines, or polygons to a map 

layer as well as edit the nodes of existing map objects.  This toolbar is only 

available when a layer in the map window has been made editable.  Its default 

location is on the map window. 

 

 

 

Select Allows you to select objects from the map.  This 

can be done by click on the object or by 

clicking and dragging a fence around a group 

of objects. 

 

 

Node Edit Allows you to edit the nodes of the select object 

 

 

Point Allows you o enter a point object with the 

current point style attributes 

 

 

Point 

Collection 

Allows you to enter several data that are linked 

to the same record or row in the table.  

 

 

Polyline Allows you to enter a polyline object with the 

current line style attributes 

 

 

Polygon Allows you to enter a polygon with the current 

region style attributes. 

 

 

Delete 

Object 

Deletes the selected object from the map layer 

 

Save Layer 

Edits 

Saves any changes made to the map 

Scale Toolbar 

The Scale toolbar contain a dropdown list of several popular 

scale settings.  By selecting one of the options the map is 

automatically change to the desired scale.  The last item on the 

list displays the scale that the map was last in and which is not on 

the list.  The default location for this toolbar is on the main 

application window. 
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Panel Windows 

One of the main features of the Geomatica LidarEngine interface is the panel 

window. Several are included with the product each having a specific function 

to perform.  In general these panels provide you with easy access to information 

about what is going on in the application.  For example one panel will list all of 

the map layers available to you in your project, another will list all of the map 

layers displayed in the current map window, and yet another will display 

information from queried locations around a map. 

Using Panel Windows 

In an effort to help you manage your working area on your computer screen 

Geomatica LidarEngine provides you the ability to control how and where these 

panel windows are displayed.  For example you may choose to dock a panel 

window to the left side of your screen so that it is always open, or you may 

choose to have the panel floating so that it can be positioned anywhere.   In all 

there are five different ways these panels can be displayed. 

View Menu 

All panel windows can be turned on or off by 

selecting them from the View menu at the 

top of the application window.  Each panel 

window is listed and a check mark appears 

beside those which are currently open.  

When a panel is turned on it will appear in 

the same location or state that it was in when 

it was closed. 

 

Docked – minimized, maximized and tabbed 

A docked panel window is one that is fixed to the edge of the 

Geomatica LidarEngine application window.  You have a choice of 

docking these panels to either the left or right side or the bottom of 

the application.  When docked to the bottom, the panel behaves 

slightly differently, these differences will be discussed shortly. 



 

38                                                            Geomatica LidarEngine User Guide 

 

 

When docked to either left or right side, the panel window can be 

positioned in three different ways, open (maximized), closed 

(minimized), and as a tab.  You can switch between these displays by 

selecting one of the small buttons in the upper right corner of each 

panel window.  The pushpin switches the display between being 

open (maximized) and a tab.   The button second from the right 

minimizes or maximizes the panel window. 

 

 

 

 

 

Also available in the upper right corner is the Change Panel view 

button.  This button allows you to exchange the contents of the 

current panel window with one that is not yet open.  When this button 

is selected a menu will appear that you can make a selection from.  If 

all panel windows are open then the menu will not appear. 

 

When in the tabbed position, you can gain quick access to the 

functionality on the panel by selecting the tab.  When you do this the 

window will appear to flyout from the side and will remain visible until 

your move your cursor from the window area. 

 

Toggle between Open and Tabbed view 

Close window 

Minimize and maximize 

Changes panel view 

Docked and tabbed 

Floating 

Docked and open 
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When docked to the bottom of the application window certain 

restrictions apply.  For example, only one window can be docked in 

the bottom position at a time and it can not be minimized or made 

into a tab. 

Floating 

A floating panel window is one which is not attached to any of the 

sides of the application window.  It can be positioned anywhere on 

your computer screen and will update automatically when required.  

To make a panel window float it must first be docked in either 

minimized or maximized viewing mode.  You then select the title bar 

of the window and drag it off towards the center of your computer 

screen.  An outline will appear to help you position its location.  You 

may find that once the window is in floating mode it may need to be 

resized.  This is done by placing your cursor at the edge of the window 

so that the resize cursor arrows appear.  Once this happens you can 

then click and drag the edge of the window to its new position.  An 

outline will again appear to help you position it. 

 

A floating window can be re-docked in two different ways.  The first 

way is to simply select the Window menu and choose one of the 

three docking options (Left, Right, or Bottom).  The second way is to 

click on the title bar and drag the window to any one of the three 

docking positions.  An outline will appear to help you position the 

window.  You will know that the window has been docked when the 

outline changes shape. 

Reordering 

If there are several panel windows docked and open, you may wish 

to change the order in which they appear.  This is done by selecting 

the title bar of the window and dragging it either up or down.  An 

outline of the window will appear and will help you position the 

window  
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Project Manager Panel Window 

The Project Manager is one of the most important features in Geomatica 

LidarEngine.  Its main purpose is to simply display and organize all of the files you 

have in your project.  As an added benefit the Project Manager has many other 

capabilities that make using Geomatica LidarEngine easy.  For example the 

Project Manager is the launching point for new map windows and adding map 

layers to existing windows.  It is also can be used as the launching point for 

operations that are performed on map layers. 

Adding and removing maps 

If you would like to add a map layer into a project, first select the 

folder in the Project Manager where you want the new file to be 

placed.  Next, right click and select the Add/Import Files option from 

the menu.  A dialog will open from which you can select the file to 

import. For more details please see the Importing and Exporting 

section later in this chapter. 
 

To remove a map file from the project, simply select the map file and 

right click.  Select the Remove from Project option and the map file 

will be deleted from the project.  It will remain in the directory if you 

need to add it back again. 

Opening map windows 

There are three ways to open a map once 

a project is loaded.  One way is to simply 

double-click on a selected map layer.  This 

action will open that layer into a new map 

window.   

Another way is to select, drag and drop a 

map layer either into an empty place in 

the application window (the gray area) or 

into an existing map window.  By dropping 

the map layer into an empty place, a new 

map window is opened.  If you drop the 

map layer into an existing map window 

then this layer will be added to it.   

The third way is to select the map layer, 

click the right mouse button and select the 

Open menu item.  This will open a new 
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map window.  If you would like to add this map to the active map 

window then choose the Open in active window menu item. 

 

Adding and removing folders 

To add a new folder to your project select the folder in which you 

would like the new one to be located. Click the right mouse button 

and select the New Folder menu item.  To remove a folder from the 

project select the folder to be removed, click the right mouse button 

and select the Remove from Project menu item.  Multiple folders can 

be selected by using the Shift and Control keys.  

Renaming files and folders 

The name of a map file or folder can be changed by first selecting 

the folder or file name, right clicking the mouse button and selecting 

the Rename option.  This will place the folder name in edit mode 

where you can type in the new name. 

Moving maps between directories 

Moving map layers between directories is performed by first selecting 

the file name to be moved.  Next drag and drop it into the 

destination folder.  Multiple files can be selected and moved by using 

the Shift and Control keys. 

Expanding and Collapsing folders 

Folders can be expanded or collapsed by 

selecting or deselecting the node icon that 

precedes the folder.  This procedure can 

also be attained by double clicking on the 

folder name. When the node icon is a plus 

sign then the folder can be expanded.  

When the node icon is a minus sign then the 

folder is already fully expanded.  You can 

expand or collapse all sub folders in the 

selected folder by clicking the right mouse 

button and selecting either the Expand All or Collapse All menu items. 
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File properties 

Additional information can be obtained on an individual map layer 

by viewing the layer properties.  This information is accessed by 

selecting the layer in the Project Manager, selecting the right mouse 

button and choosing the Properties menu item.  

Exporting project files 

You can export any map layer within the project to any of the support 

file formats by first selecting the file to export, then clicking the right 

mouse button and selecting the Export menu item.  A dialog will 

appear that will allow you to choose the new file name and the 

format in which you wish to export. See the Exporting section later in 

this chapter for more details. 

Launching solvers and wizards 

One of the three ways of launching a solver or analytical wizard is 

from the Project Manager.  This is done by selecting the file you wish 

to perform the analysis on, clicking the right mouse button, and then 

choosing either the Solvers menu item or the Wizards menu item.  In 

either case the resulting flyout menu will only display those solvers or 

wizards that are appropriate for the selected map file. 

 

Layer List Panel Window 

The Layer List panel window is the central command 

post for features that control the view of the map 

window.  With the layer list you can select which 

map layer will be the current one, change the order 

in which layers are displayed, turn on or off the 

visibility of a map layer in the map window, and 

even turn on or off labels.  Unlike other panel 

windows, the Layer List has a dynamic view in that it 

always reflects the content of the current map 

window.  In addition, any changes to the settings 

are immediately reflected in the map window. 

Layer Order 

The order in which the layers appear in the Layer List is quite important 

as it controls the draw order for the map window. When a map 
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window is rendered, the map layer on the bottom of the list is drawn 

first and the one on the top of the list is drawn last.  Without being 

able to control this order some map layers may hide others, for 

example if you had a point file of customers as the bottom layer and 

a region layer of land use classification on top, the customer map 

layer would not be visible. 

As a general rule, you are going to want map layers with point 

objects at the top of the Layer List, line and polyline map layers 

below, region layers next, and grids and images on the bottom. 

 

To change the order of the map layers in the Layer List simply highlight 

the layer you wish to move and select the Order Up and Order Down 

buttons that appear on the bottom of the panel window. 

 

Layer Settings 

For every map layer displayed in the Layer List 

there is a check box for each of the following 

settings; Visible, Editable, Selectable, Labels and 

Names.  A description for each of these is 

provided below.  If you wish to conserve space 

on the panel window you can remove from view 

any of the four settings by placing your cursor on 

one of the icons and selecting the right mouse button.  When this is 

done a menu will appear that you can check or uncheck.   

 

 

The Visible check box makes the map layer visible or invisible in the 

map window. 

 

The Editable check box allows you to make changes to the objects 

on a map layer.  If the map is not selected as editable, you can 

make no changes to the map layer. 

 

The Selectable check box allows you to select map objects from 

the map window. 

 

The Label check box turns on and off the labels for the selected 

map layer.  See the section on labeling for details. 
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Scratchpad Layer 

The Scratchpad Layer is a temporary map layer available to you for 

casual use.  You can add and remove any kind of map object to it 

that you do not want added to an existing map layer.  One basic 

characteristic of the Scratchpad layer is that it is always the top layer 

in the Layer List and it can not be reordered down the list.     

 

Removing Layers 

Layers can be removed from the map window by selecting the 

desired layer and clicking the Remove Layer button located on the 

bottom of the panel window. 

 

Map Labels 

The objects on a map layer can be quickly and automatically 

annotated by turning on the labels for the layer by checking the 

Label check box.  By default Geomatica LidarEngine labels each 

map object in the layer using the information contained in the first 

column of the table.  You can make modifications to these labels 

such as changing the column it labels, by selecting the Label Options 

button located on the bottom of the Layer List panel window. 

 

Master Grid Layer 

The master grid layer is the grid layer that has the star icon beside its 

name in the Layer List.  Its main purpose is to identify which grid layer 

will be used as the reference grid when displaying maps in the 3D 

window.  You can change the master layer by selecting a different 

grid in the Layer List and the clicking the Set as Master Grid button 

located at the bottom of the panel window.  This button is only 

available when a grid has been selected. 

 

Grid Colorizer 

When a grid layer is selected you can access the Grid Colorizer tool 

for that grid by selecting the Colorizer button located on the bottom 
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of the panel window.  When selected, a dialog appears that allows 

you to edit the colors used to display grid values and the range of 

values which each color represents.   

Layer Transparency 

A level of transparency can be applied to any layer in a map. The 

degree of transparency for the selected layer is displayed in the 

bottom right corner of the Layer List and is expressed as a 

percentage.  A value of zero indicates that no transparency has 

been applied and a value of 100 indicates the layer is invisible. 

The transparency level can be modified in two ways.  The first is to 

place your cursor in the edit box where the transparency value is 

displayed and simply enter in a new value.  The second is to select 

the dropdown arrow located to the right of transparency value.  

When the slider bar appears move it to the left and right to change 

the transparency level. A readout of the current transparency level is 

displayed. 

 

 

Information Window 

The Information panel window is used to display any attribute information 

associated with all map objects found at the queried location regardless of 

which layer they are on.  The results are nicely organized so that the information 

you are looking for is easily detected. This tool also provides the ability to 

customize the display so that only the columns of a particular layer are shown..   
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Using the Information Window 

The Info tool is initiated by selecting the tool button from the Layer 

toolbar which by default is located in the map window.  As soon as 

the tool is selected the Information window appears.  To inspect the 

values at a location on the map simply click on the map.  When a 

location has been selected the Information window will then be 

populated with the value retrieved from each active layer in the 

Layer List.  

 

The display is divided into two sections.  On the left side is a tree view 

display listing all of the layers and objects found.  Within each layer 

objects are organized by their type, for example polylines, regions 

and points. It is in these categories that each queried map object is 

listed.  By default the text displayed for the map objects is what is 

found in the first column in the database.  You can customized the 

display using the Info Layer Parameters dialog, see next section. 

 

On the right side of the panel window is a display of all of the attribute 

information associated with the selected item on the left.  Information 

is displayed for all levels in the tree view, for example, if the layer 

name is selected then information about the layer is displayed 

(project name and number of objects).  If the object type is selected 

then a listing of all columns in the database are displayed.  If the 

object is selected then all attribute information is displayed.  This can 

be customized using the Info Layer Parameters dialog, see next 

section. 



 

Geomatica LidarEngine User Guide                                                                                           47  

Customizing the Information Window 

The information displayed in the Information window can be 

customized on a layer by layer basis through the Info Layer 

Parameters dialog.   To access this dialog select the Info Layers menu 

located on the Information panel window.  This menu will display a 

listing of all layers in the current selection.  If the menu is empty simply 

select the Info tool and make a query from the map.  

 

 

From the Info Layers menu choose the layer that you would like to 

customize the display.  The Info Layer Parameters dialog will appear 

like the one shown above.  The main purpose of this dialog is to 

identify what information from the layers database will be displayed in 

the Information panel window. 

 

Primary Column – a check box that defines which column of 

information will be displayed in the tree view located on the left side 

of the Information window.  Only one column can be checked as the 

primary column at a time. 

 

Columns – lists all of the columns in the database for the selected 

map layer. 

 

Show Column – a check box that defines which columns of 

information that will be displayed on the right side of the Information 

panel window.   
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Process Manager Panel Window 

A unique feature in Geomatica LidarEngine is the ability for you to monitor and 

control multiple processes at the same time.  The multithreading capabilities of 

Geomatica LidarEngine allow several processes to be run simultaneously.  The 

purpose of the Process Manager Panel is to display all processes that are 

underway and to report their progress by providing a percent complete value.  

Although there are no limits to the number of processes that can be running at 

one time, there can be a significant increase in processing time, as system 

resources are used. 

 

 

 

In addition to the Process Manager, a progress bar also appears in the bottom 

left corner of the Geomatica LidarEngine application window.  This progress bar 

displays the progress of the top most process in the Process Manager.  This allows 

you remove the Process Manager from view and conserve desktop space when 

there is only one process running. 

Using the Process Manager panel 

The Process Manager does not automatically open when a process is 

first initiated and therefore the panel window will have to be opened 

manually from the View menu.  The window itself is made up of two 

resizable columns, one containing the name of the process and the 

other a progress bar.  Each of these columns can be resized by 

selecting the divider between the columns and dragging either left or 

right.  

Pausing a process 

 
To Pause a process, select the desired row in the window and 

select the Pause button, shown at left.   If there are multiple 

processes running you can speed up one of them by pausing or 
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stopping the others. 

Stopping  a Process 

 
To Stop a process, select the desired row in the window and select 

the Stop button, shown at left.  If there are multiple processes 

running you can speed up one of them by pausing or stopping the 

others. 

Getting more information 

 
You can get more information on a process by selecting the Info 

button.  Once selected, the bottom of the dialog expands and 

provides you more detail on what stage the process is at.  For 

many solvers there is not much additional information to provide, 

however some solvers involve multiple steps and therefore having 

the extra information can be helpful.  The Watershed Analysis tool is 

one such solver that performs several steps  
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Workbench Panel Window 

The Workbench panel window organizes all solvers and wizards that Geomatica 

LidarEngine offers into a convenient and logical folder structure making it 

relatively easy to search and launch an operation.  In addition to listing all solvers 

it also includes a Favorites folder that you can list the ones you use most often.  

The workbench is one of three ways in which an operation can be initiated.  The 

other two are from the Project Manager and the Solvers menu on the main menu 

bar. 

 

Using the Workbench Panel 

The Workbench panel, like other panel 

windows, is open and closed using the 

View menu on the main menu bar 

located at the top of the application 

window. 

Building a list of favorites 

At the top of the Workbench panel is a 

folder called Favorites.  This folder is 

made available for you to organize the 

solvers and wizards that you use most 

often.  This saves you the time of 

searching through all the items in the list, 

you can simply launch the process from 

the Favorites folder. 

To add a solver or wizard to your 

Favorites folder simply select the item 

and drag and drop it into the folder.  This 

action makes a copy of the original item 

so you do not have to remember putting 

it back where you got it when you start 

another project. 
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Views Manager Panel Window 

One of the ways Geomatica LidarEngine helps you to manage the map windows 

you have open, is to save their to the Views Manager panel.  This ability to save 

map window settings, allows you to freely close map windows without fear of 

losing work you have already done. 

Using the Views Manager window 

The Views Manager is a panel window 

that simply lists all of the map window 

views that have been saved.  These 

views are automatically saved to your 

project and therefore will always be 

available to you whenever it is opened. 

When a view is saved, not only is the 

viewing perspective of the map saved 

but all of the Layer List settings are also 

captured.  For example the order in 

which the maps are layered, and 

whether a layer is visible or invisible are 

also saved. 

 

Saving a map view 

 
To save a map window view first make the map window is currently 

active by clicking on and highlighting the window’s title bar.  Next, 

choose the Save View button at the bottom of the Views Manager 

window.  When this is done a new view will appear in the view list.  

The title of the new view will automatically be made editable so 

that you can change it to a more appropriate name. 

Removing a map view 

 
To remove a saved map window from the Views Manager simply 

highlight it and select the Delete button located on the bottom of 

the panel window. 
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Opening a map view 

 
There are two ways of opening an already saved map window.  

The first is to simply double click on the view title listed in the Views 

Manager.  The second is to highlight the view title and select the 

Open View button located on the bottom of the panel window. 
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Log Manager Panel Window 

The Log Manager panel window displays a comprehensive listing of all the 

different events that have occurred within Geomatica LidarEngine.  In all cases 

the date and time of the event is captured and any interim steps that are 

applicable in larger processes.  The value of this feature is that you do not need 

to be present when a process is complete too know how long it took.  Multiple 

processes can be set in motion overnight and with the Log Manager a better 

understanding of time requirements is possible.  This allows for better optimization 

of computer processing time for jobs that do not need user assistance. 

 

 

 

It should be noted that not all events are captured, for example an open map 

window event is not captured however a deletion of a map from the project is 

and so is a process such as an interpolation. The Log Manager can be opened 

from the View menu on the main menu bar at the top of the application window.  
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Geomatica LidarEngine Projects 

In Geomatica LidarEngine all files that are used in a mapping session are kept 

within the structure of a project.  A project is a way of keeping files organized so 

that they can easily be accessed when you need them.  Within the interface of 

the program, a project is accessed through the Project Manager panel window.  

From this window, folders and map files can be added and removed, and maps 

can be moved between folders.  

When you first open Geomatica LidarEngine you will have one of two choices, to 

either open an existing project or to create a new one.  Creating a project for the 

first time is a very easy two step process that uses the Project Wizard.  In the first 

step of the wizard you simply identify the name and location on your computer 

that will hold the contents of the project as well as any sub folders.  In the second 

step you identify what files you would like to have in the project and which folders 

they will be stored in. 

Essentially there are two approaches you can use for creating a new project.  The 

first is to use the Project Wizard to the full extent to which was designed, define 

the folder structure and identify the maps to be included.  The second approach 

is to only identify the name and location of the project in the Project Wizard.  

Once the project has been created you then define the folder structure and add 

maps files using the Project Manager panel window. 

In Geomatica LidarEngine there is no need to manually save your project.  Any 

time a change is made to the project such as adding or removing map files the 

project is automatically saved.  The actual project file itself that contains the 

instructions for opening the project is an ASCII text file located in the project 

directory.  The name of the file will be the same name as the project and will 

have an .ipr extension.   This file can be opened and edited in any text editor if 

need be. 

 

In order to take advantage of many of the data access and display 

improvements that Geomatica LidarEngine has made over existing mapping 

systems the data contained within the project must be in the Geomatica 

LidarEngine native file format.  This is a seamless process, all you have to do is 

identify which files you would like to see in your project and Geomatica 

LidarEngine does the rest of the work.  Once you have finished analyzing the 

data getting the results back out is matter of saving them in the desired new data 

format.  In this way Geomatica LidarEngine makes for a perfect fit to an existing 

mapping system allowing you to get your data in and get the analysis files back 

out. 



 

Geomatica LidarEngine User Guide                                                                                           55  

 

Using the New Project Wizard 

The New Project Wizard is a two step wizard that is accessed by either selecting 

the New Project on the Main button pad or by selecting the New Project menu 

item from the File menu. If a project is already open and you initiate the creation 

of another one then the current project is automatically closed. To help you 

visualize the project as it is being built both wizard steps contain a window 

displaying the folder structure. By default a folder called Analysis will be added to 

the project.  It is in this folder that all solver outputs will be placed. 

Step 1 – Folder structure 

In the first step of the wizard you will specify the name and location of the main 

project folder as well as any sub folders.  The following is a description of all 

settings available in step one of the wizard. 

 

 

Project name – enter the name of the project that will be created.  

This will be the name of the folder. 

Location  - specify the location on your computer system where the 

project folder will be located.  To navigate to the location select the 

Browse button. 

New folder name – specify the name of the folder to be added to the 

project.  Once you have typed in a name select the Add button to 

enter it into the project.  It should appear in the project view window 

on the left side of the dialog.   To remove a folder that has been 
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added, select it from the project view window and select the 

Remove button. 

Next – select the Next button to move to the second step of the 

wizard. 

Step 2 – Adding files to the project 

In the second step of the wizard you will specify which map files you will be 

adding to the project and in which folders they will be placed.  This step of the 

wizard is divided into two windows.  The window on the left displays the folder 

structure of the project defined in step one.  The window on the right lists all of the 

files that have been identified to be placed in the selected folder. 

 

To begin, first select one of the folders listed in the project view window on the left 

side of the dialog.  This identifies which folder the selected files will be added to.  

Next, click the Add button located on the bottom right.  The Open dialog will 

then appear allowing you to navigate to where the map files are located on your 

computer system.  By default the Files of type option is set so that all the data 

formats that Geomatica LidarEngine can open are listed.  If you would like to 

view only a specific file type then choose it from the drop down.  For more details 

on the types of files that can be brought into Geomatica LidarEngine please see 

the Importing section later in this chapter. 

 

 

 

Once map files have been identified you can change the name of the map file 

as it appears inside the Geomatica LidarEngine project.  To do this simply select 
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the file from the file list window and select the Set Open As button.  A small dialog 

will appear that will allow for the name change of the map file.  A file can be 

removed from the file list by selecting the Remove button. 

 

If at this point you wish to add another folder to the project, simply select the 

Back button located on the bottom of the dialog, this will bring you back to step 

one of the wizard.  You will not lose any of the work already completed, unless a 

folder is removed that already had files assigned to it. 

 

When you have finished adding files to the project and are ready to complete 

the project creation process, select the Finish button.  When this is done, 

Geomatica LidarEngine will build the folder structure and begin converting all of 

the identified files into the Geomatica LidarEngine data format.  The Process 

Manager will automatically open and track processing for you. 

 

It is recommended to create an empty project structure first and then to use 

import capabilities to populate it with the data. 
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Opening a project 

Each time a project is opened Geomatica LidarEngine performs a check on 

every file to ensure the integrity of the file is still intact.  You can watch this process 

as the file icon next to the file name changes from an orange “Waite” icon to 

one with another picture.  The icon simply represents the type of data such as 

vector, raster grid or raster image etc. 

 

If Geomatica LidarEngine detects that the file has been corrupted or physically 

no longer exists in the project folder then the file icon will become a red “X”.  In 

no way will this adversely affect the opening of the project; it simply means that a 

particular file can no longer be opened.  These files can be removed from the 

project at any time by selecting them, clicking the right mouse button, and select 

the Remove from Project menu item. 

Project files 

The project consists of two file types which help build the project you load in 

Geomatica LidarEngine.  An .ipr file contains information on the directory 

structure of the project, such as the project name and the directory names within 

the project tree.  The second file type is the .ips file.  This file contains the 

information about the layout of the project.  This ensures the same windows are 

opened each time a project is saved and then re-opened.  For example, it 

describes where the Layer List is docked or the extents of the Views Manager 

window.  Both of these project files are ASCII text files therefore they can be 

viewed and edited in any text editor. 

 

Importing Map Layers 

When files are selected and brought into a project they are converted to the 

native Geomatica LidarEngine data format, the .ISD file.  In this format 

Geomatica LidarEngine can take advantage of many efficiencies that would be 

impossible if the data files were read directly from their 

original format.  For example it would be impossible to 

get the display speeds from an ESRI .ASC grid file. 

 

There are three was in which a file can be imported 

into the project.  The first is to select the files using the 

Project Wizard as already described in this section.  This 

method is only available when starting a new project.  

If you already have a project open then you will have 



 

Geomatica LidarEngine User Guide                                                                                           59  

to use the second or third method.  The second method is to select the Add 

Project Layer button located on the main toolbar located at the top of the main 

application window.  The File Open dialog will appear from which the files to be 

imported can be selected.  When the Open button is selected the Directory 

Selector dialog will appear, see right.  It is from this dialog that you will choose into 

which project folder the files will be imported. 

The third method is from the Project Manager.  For this method first select the 

folder you wish the files to be located.  Select the right mouse button and choose 

the Add/Import Files menu.  The File Open dialog will then appear from which the 

files to be imported can be selected.  When the dialog is dismissed the selected 

files will be instantly imported.  Each file being imported is considered a separate 

process which can be tracked in the Process manager as separate progress bars.  

For most data files the importation process is relatively quick. 

 

Supported Import Formats 

Geomatica LidarEngine supports many of the 

more popular spatial data formats including 

MapInfo and ESRI formats.  By default the File 

Open dialog searches and displays all of the 

format types it recognizes.  If there is a specific 

format type that you wish to filter by then make a 

selection from the Files of type dropdown as 

shown below.  The following sections identify the 

file formats that are supported in Geomatica LidarEngine. 

Vector Data Formats 

Extension Description 

.isd AmberCore Spatial Data format - the native data format for 

Geomatica LidarEngine. An .isd file can be either a vector or 

raster data format. 

.tab 

.mif/.mid 

MapInfo Professional formats – The .tab format is the native 

data format for MapInfo Professional.  In actuality it is just a 

pointer to the actual data which could be raster vector or just 

a table.  The .mif/.mid format is an ASCII formatted data type 

specifically used for data exchange. 

.shp ESRI Shape format   - the native vector data structure for ESRI’s  

.txt ASCII text format – An ASCII text formatted file that is 

delaminated with tab, comma or some other character.  This 
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format is typically used for point data.  

Grid Data Formats 

Extension Description 

.mig MapInfo grid format – the native grid format used by MapInfo 

Professional. 

.asc 

.flt 

ESRI grid formats – two formats are support the .asc format 

which is an ASCII grid format and the .flt format which is a 

binary floating point format.  It should be noted that importing 

.flt formatted grids is 2 to 3 times faster than .asc formatted.    

.grd 

.grc 

Northwood grid format – used by Vertical Mapper a popular 

raster analysis module for MapInfo Professional.  Two format 

types are recognized .grd (numeric grid data) and .grc 

(character based data). 

.dt0 USGS - Digital Terrain Elevation Data format 

.ddf USGS - Spatial Data Transfer Standard (SDTS) format. Only the 

surface or grid layer is imported. 

.dem USGS - Digital Elevation Model format 

CDED  - Canadian Digital Elevation Data format 

Image Data Formats 

Extension Description 

.tif Tagged Image File Format – two format types with this 

extension are support, regular unregistered .tif images and 

georeferenced GeoTIFF images. 
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Note:   After importing a map layer it is a good practice to ensure that the 

correct projection system was applied by Geomatica LidarEngine.  At times the 

map layer will be imported with an “Undefined” projection and coordinate 

system.  If this occurs then you will have to manually assign them. 

This is generally not a problem when importing map layers from the MapInfo .tab 

format as the projection information is embedded in the file.  However, projection 

information is not embedded in the ESRI Shape file format and therefore the 

importation of these may result in an undefined projection and coordinate 

system.   

In ESRI’s ArcView/ArcGIS products the projection information is associated with a 

project and located in a file with a .prj extension.  Due to this, if a Shape file is 

removed from the original project folder then the projection information is lost 

and therefore must be manually assigned when imported into Geomatica 

LidarEngine.  

To help mitigate this problem Geomatica LidarEngine automatically searches for 

a .prj file in the directory where the Shape files are stored.  If it finds one then this 

projection will be applied to all files imported. 

 

 

Opening External Project Map Layers 

When a map layer is imported into a project you will have noticed that it is stored 

in one location within the project directory on you computer’s hard drive.  

Although it is often convenient to have all project files located in the same place 

there are some instances where it is impractical.  For 

example, you may have several projects that utilize 

the same map layers.  In this instance it is not 

practical to have duplicates of the map layers in 

each of the projects especially if the map layers are 

large in size.  In this instance it would be more 

beneficial to give each project access these share 

map layers from a single location eliminating the 

need for duplication. 

 

Accessing map layers outside of the current project 

can only be done from the Project Manager.  This is 

done by selecting the folder the file(s) will be located 
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in, clicking the right mouse button and choosing the Access External Files (Read 

Only) menu.  The File Open dialog will appear from which the files to share can 

be selected. 

 

Only maps in the native Geomatica LidarEngine file format (.isd) can be selected 

to be shared.  It does not matter if they are already associated with another 

project they can still be accessed in this manner. 

 

If the map layer you wish to access is associated with another project then 

identifying this layer is much easier if you choose the project file from the File 

Open dialog. The File Open dialog recognizes two file types, the Geomatica 

LidarEngine native file type (.isd) and the Geomatica LidarEngine project file 

(.ipr).   When the project file is chosen then a supplementary dialog appears 

providing a listing of all the map layers contained in that project, shown at right.  

You are able to select one or more map layers by checking the box provided. 

 

Shared map layers are read only.  Although they can be modified within a single 

session any changes will not be saved.  Edits can only be made when the project 

they are directly associated with is opened.  In the Project Manager a shared file 

can be identified by the italic font used for the layer name. 

 

Exporting Map Layers 

Exporting map layers to other data structures can only be performed from the 

Project Manager.  This is done by selecting the map layer to be exported, clicking 

the right mouse button and selecting the Export menu option.  Only one file can 

be exported at a time.   The Save As dialog that appears is sensitive to the file 

type initially selected.  For example if a vector was selected then only vector 

formatted export types will be presented.  The same is true for raster formats.  The 

following list outlines the file formats that are supported in Geomatica LidarEngine 

for each format type. 

 

Vector Data Formats 

• MapInfo table format (.tab or .mif/.mid) 

• ESRI Shape format  (.shp) 

• ASCII text format (.txt) – table information only 
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Grid Data Formats 

• ESRI grid format (.asc or .flt) 

• Northwood grid format (.grd, .grc) 

• ASCII text format (.txt) – table information only 

 

Image Data Formats 

• ESRI grid format (.asc or .flt) 

• ASCII text format (.txt) – table information only 
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Creating Output 

Geomatica LidarEngine provides you several ways of creating output for your 

maps, printing a map window, saving it as an image file, or exporting it to the 

Google Earth™ KML format.  

 

Printing the map window 

The Print feature in Geomatica LidarEngine simply takes the extents of the current 

map window and applies it to the default page size as set by your default printer.  

The size of the map on the page is automatically fitted so that it is maximized 

within the default margins. 

Printing 

 

When printing a map window, make sure the window you wish to 

print is the current window.  Once this is done, simply select the Print 

button located on the Print toolbar. 

Geomatica LidarEngine uses the extents of the map window to 

identify what part of the map will be sent to the printer.  Therefore if 

you wish to have a particular area printed make sure you zoom-in 

to that area or resize the map window to include the area. The area 

printed will be maximized to fit the page.   

 

Print Preview 

 

To get an idea of what the final output will look like, select the Print 

Preview button located on the Print toolbar.  When you use this 

feature notice that the name of the map being printed is displayed 

in the upper right side of the page. 
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Saving a window as an image 

An effective way of getting the contents of a map window into another 

application is to save the window as an image.  Geomatica LidarEngine provides 

you with four of the most popular image formats to save you data in.  They 

include Windows Bitmap (.bmp), Join Photographic Expert Group (.jpg), Tagged 

Image File Format (.tiff), and Portable Network Graphics (.png) 

 

 

When saving a map window to an 

image, make sure the window you 

want to save is the active window.  

Once this is done click the “Save map 

as image” button located on the Print 

tool bar. 

In the Save window as dialog click the 

ellipse button (…) to enter a file name 

and folder location for the output.  

From the “Saves as type” dropdown 

choose the one of the four image 

types. 

Depending on the file type you choose 

you may have the option to compress 

the output file. 

.bmp – no compression available. 

.jpg – compression is available, move 

the slider bar to change compression 

amount. 

.tif – compression available, from the 

Compression Method dropdown 

choose either no compression or the 

LZW method.  Move the slider bar to 

change the compression amount. 

.png – no compression available 
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Google Earth™ 

An effective way of sharing the results created in Geomatica LidarEngine is to 

export them to a format used by Google Earth™.  Google Earth™ is a unique 

visualization tool for geographic data that can be downloaded for free from 

http://earth.google.com/. 

 

Exporting to the Keyhole Markup Language (KML) format is as simple 

as selecting the Google Earth™ button located on the Output 

toolbar.   This button is only available when the active window is a 

map window. Two types of outputs can be generated, an image of 

the entire map window or individual layer or a vector copy of an 

individual vector layer.   The output format entirely depends upon 

what has been selected to be exported as defined by the selected 

layer in the Layer List.  Whether exporting to an image or a vector 

format only the area being viewed in the map window will be 

exported. 

Image Output 

There are three instances when an image will be produced when 

exporting a map into the Google Earth™ KML file format.  The first 

instance is when the selected layer is of a raster type, for example a 

grid or satellite image. The second instance occurs when all layers in 

the map window are to be exported.  The third instance only occurs 

when the selected vector layer contains more map objects than the 

threshold specified in the Preferences dialog (see Vector Output).    

For image outputs two files are created.  The first is the KML file which 

contains the location and display information required by Google 

Earth™.  The second is a PNG image file captured from the map 

window.   By default these files are saved to the Google KML folder 

located in your project directory.  During the export process the can 

target directory can be change if desired. 

Vector Output 

A vector output is created only when a vector map layer is selected 

for export.  The export will include those map objects that are entirely 

or partially visible within the map window. 

It is important to note that Google Earth™ has a practical limitation 

when handling vector layers with a large number of geographical 
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objects (points, lines, regions).  When vector files are imported with 

more than 1000 objects Google Earth™ begins to perform extremely 

slow.  This performance is entirely dependant on the processing 

power of you computer system and the threshold at which this will 

occur may be higher or lower than 1000 objects. 

To mitigate this limitation Geomatica LidarEngine implements a 

threshold that when it is exceeded an image of the map layer will 

automatically be produced instead of the vector output.  This can be 

set in the Preferences dialog (File > Preferences).  There are two 

threshold values.  The first defines the minimum number of objects 

under which the vector result will automatically be created.  The 

second defines the maximum number of objects over which an 

image result will automatically be created.  If a map layer has 

number of map objects between the minimum and maximum 

threshold levels then a warning will appear and choice must be 

made to whether a vector or image result is to be created. 

Projection Requirements 

Google Earth™ requires that all geographic data be in the WGS 84 

projection system.  If you map is not in this projection then a warning 

message will appear indicating that a conversion is necessary.  By 

accepting this dialog the projection of map window will be 

converted using the On-the-fly projection feature.  This conversion will 

only affect the map window, the original map data will not be 

altered. 

Export Dialog 

 

Map Layer to export – a dropdown list of all layers contained in the 

current map window.  By default the map layer highlighted in the 

Layer List is selected to be exported.  A different layer may be chosen 

by selecting the dropdown and choosing another from the list.  If the 

Combine picture item is selected then all layers contained within the 

amp window will be exported to an image. 
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KML Layer name to be created – 

defines the name of the KML file 

that will be produced and the 

name of the data layer that will 

appear in the Google Earth™ 

Places window. 

 

Semantic Fields – A tab 

containing a listing of all fields in 

the database of a vector file.  

Only those fields that are 

checked will be included in the 

KML export file and be accessed 

in Google Earth™.   

This tab will be grayed out if a 

raster file was selected for export from this tab. 

  

Object type – a dropdown list of the different object types contained 

within the selected layer that will be exported.  Geomatica 

LidarEngine stores different object types in separate tables within the 

ISD file and therefore the semantic fields will have to be chosen by 

object type.  If only one object type is contained within the map layer 

then this option will be grayed out. 

 

Create Placemark label with – a 

check box indicating that a place 

marker will be created for each 

object contained within the map 

layer. When checked a dropdown 

becomes available from which 

the label field can be chosen. It is 

from the data in this field that 

each place marker will be labeled 

with.  

 

Angle View – a tab containing 

two settings that control default 

viewing angle.  The Azimuth 

setting defines the compass 
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direction from which the geographic information will be viewed.  The 

Inclination setting defines how far off the horizon the information will 

be viewed.  Both of these settings can be edited by clicking on the 

corresponding Sun icons and dragging them to a new location on 

the respective graphics or by entering a new value in the edit boxes 

provided. 

Launching Google Earth™ 

Once the output files have been saved and if Google Earth™ is 

installed on your computer system then a dialog will appear asking if 

you would like to see the results in Google Earth™.  If this is accepted 

then Google Earth™ will be launched and the scene displayed. 
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Table Window 

As you may already be aware, each map layer in a digital mapping system 

generally has some kind of attribute information associated with each object on 

the map.  For example roads will have road names and address ranges, county 

boundaries will have county names and population statistics, and points will have 

customer names and billing information.  All of this information is displayed in a 

spreadsheet or table like structure, where each row contains the information 

associated with a single map object.  In this regard Geomatica LidarEngine is no 

different the product includes a special window called the Table window that 

displays a maps attribute data. 

What is quite unique to Geomatica LidarEngine is the way the Table window has 

been designed to be the focal point of all operations involving the table.  Not 

only does it include manipulating what is viewed in the window, i.e. hiding 

columns and changing column widths, it also includes such operations as 

updating columns, creating new columns, and opening map windows of 

selected records.  In an effort to increase the usability of the window, a specialize 

toolbar and menu have been provided that make many of these operations a 

one click solution. 

Another unique feature to Geomatica LidarEngine is how the Table window 

provides you access to style attributes and the node structure for each map 

object.  Essentially information about a map object is divided into three 

categories, style information, architecture information, and attribute information. 

Style information includes things like the color of a region or the style of the 

symbol.  Architecture information refers to the coordinate values of the nodes 

that make up each object, this not only includes the x and y-values but the z-

values are also accommodated.  Attribute information includes any other 

information about the object such as the county name or customer contact 

information.  Within the Table window these different categories of information 

can easily be turned on or off by simply clicking a button on the Table window 

toolbar. 
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It is important to note that the table window and the map are dynamic linked.  

This means that changes to one instantly changes the other, for example, if 

records are deleted from the table then the corresponding map objects are 

deleted from the map, and vise versa.  The table and map window are a direct 

reflectance of the information contained in the other.  

 

Opening the Table Window 

The Table window can be opened in two different ways.  One way is to select the 

map layer in the Project Manager, click the right mouse button and choose the 

Open Table menu item.  The other way is to select the Open Table button from 

the toolbar in the map window.  The Open Table button will open the table 

window for the active map layer in the map window, highlighted layer in the 

Layer List.  

 

When the table is opened for the first time the collapsed view is displayed, it will 

look something like what is shown below.  Essentially a single field is displayed 

containing a value that corresponds to the number of records in the table.  To 

expand the table to the full view first click on the “+” sign located in the first 

column. 
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Next select the link that will display in the second row. 
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Table Window Toolbar 

The Table window has its own tool bar that help you manipulate what is viewed in 

the window.  These features are briefly described below. 

 

 

 

Different 

Windows 

Applies any changes to the window to a new 

window 

 

 

Clear Table 

Styles 

Clears all formatting that was applied to the 

window and brings it back to its default viewing 

state.  

 

 

 

Show/Hide 

Columns 

This is a toggle button that switches the view of 

the window from the default viewing state to 

the one you have customized. 

 

 

View Attribute 

Columns 

This is a toggle button that turns on and off the 

attribute columns. 

 

View Spatial 

Columns 

This is a toggle button that turns on and off the 

architectural information about each object. 

 

View Style 

Columns 

This is a toggle button that turns on and off the 

style columns for each object. 

 

 

Edit Mode This is a toggle button that allows you to make 

edits to the data in the table.  Edit mode is on 

when the check mark appears in the button 

icon. 

 

Save Saves any changes made to the data within the 

table. 

 

Save Selection 

As 

Saves the current selection to a new file. This 

button is only available when a selection has 

been made. 

 

Simple Query Launches the Simple Query dialog that allows 

you to perform a mathematical operation on 

the data. 

 

Map Opens the map objects of the currently 

selected rows into a map window. 
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Right Click Menu 

There are a variety of options available from the 

Table window menu.  You access this menu by 

placing your cursor on one of the column titles 

and clicking the right mouse button.  The menu 

item you choose will be applied to the column 

that you opened the menu from.  There are four 

operations that can be performed from the 

menu, they are; hiding columns, showing 

columns, renaming columns, changing the 

column width, and updating a column. 

 

Hiding columns 

The Hide option on the Table menu simply removes from view the 

column that the menu was accessed from.  For example, if you right 

click on the ID column and select the Hide option from the menu then 

it will be the ID column that will be removed from the view. You can 

make a column visible again though the Columns Dialog, see Show 

Columns.  

 

Show Columns 

The Show Columns option opens the 

Columns Dialog.  This dialog displays a 

listing of all the columns available to be 

viewed in the table and identifies those 

that are currently visible with a check 

mark.  You can make a column visible 

that was previously hidden by simply 

checking the checkbox for the desired 

column.   

 

Rename a column 

Changing a column name to an alias is done by selecting the 

rename option.  The alias name will have an asterisk in front of it so 

that it can be distinguish from the real name.  Certain operations 
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require the real name of the fields not to change, therefore the alias is 

only for visual purposes and will not directly change the column’s 

name.  Alias names can be removed by selecting the Clear Table 

Styles button 

Changing the column width 

The width of the columns can be changed in two ways.  Selecting the 

width option from the right click menu allows you to use a specific 

distance for the width.  Another method is to hold the cursor between 

the fields, click and then drag the arrows in the direction you wish to 

go.  

 

Selecting Records 

Manual Selections 

A record can be manually selected by clicking on the first cell in the 

row.  This is also the cell that contains the “+” sign.  When the row is 

selected it will be highlighted a blue color. To select several rows at 

one time you will have to use the Shift and Control keys on your 

keyboard. If you would like to select several consecutive rows then 

first select the top record of the group, hold down the Shift key and 

then select the bottom record of the group.  All records between the 

two selected will be highlighted.  Individual or non-continuous records 

can be selected by holding the Control key. 
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Simple Query 

The Simple Query tool allows you to 

make selections of records from the 

table. 

A column is added to the expression by 

double clicking on the column in the 

Columns list.  The name of the chosen 

column will appear in the expression 

window at the bottom of the dialog.    

Other elements of an expression can be 

added by selecting one of the provided 

tabs, NumberPad, Operators, and Text.  

On each of these tabs buttons are 

provided for each available element of 

the expression. 

If a mistake is made in the expression 

then edits can be made by selecting the 

Backspace or the Clear buttons.  The 

Backspace button erases the last 

element entered into the expression.  The Clear button erases the 

entire expression. 

 

The Verify button will indicate whether the entered expression is valid. 

Saving a Query 

A selection or query can be saved by choosing the Save selection as 

button located on the Table Window toolbar.  This will save the 

contents of a selection as a separate map layer and store it in the 

Query folder located in the Project Manager.  Once selected the 

Save Selection As dialog will appear prompting for the name of the 

query and whether you would like to a map or table of the selection 

automatically opened. 

Mapping a Selection 

When a selection is made from the table a map can be instantly 

generated to show you where these are located.  This is done by 

selecting the Map Window button on the Table Window toolbar.  
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Once selected a map window will appear with the selected elements 

highlighted with a blue line. 

 

Editing and Saving 

Editing records 

To edit any of the information in the table you must be in edit mode.  

Edit mode is a safety feature preventing you from making any 

unwanted changes.  To get into edit mode select the Edit Mode 

button located on the Table window toolbar.  You should notice that 

the red “x” changes to a green check mark once it is engaged. 

Once in edit mode you can place your cursor in any column and 

make changes to the data.  There is no need to save your changes 

as they are automatically saved to the table 

Saving Changes 

To save any changes that you may have made to the table select 

the Save Changes button located on the Table Window toolbar. 

 

Attribute Columns 

The attribute columns can be toggled on and off by selecting the 

Attribute Columns button on the toolbar. 
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Style Columns 

The style columns can be toggled on and off by selecting the Style 

Columns button on the toolbar. 

 

Spatial Columns 

The spatial columns can be toggled on and off by selecting the 

Spatial Columns button on the toolbar.   
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Map Legends 

One of the most important elements of any map is the legend.  This is because it 

contains all of the necessary information that will help you to correctly interpret 

what the map is trying to portray.  Among the many legend elements that you 

will likely see on a paper map are things like a North arrow indicating the correct 

direction, a scale or scale bar to help you understand distances, and a key that 

helps you to understand what each color and symbol represent.  Although these 

elements are important in a digital mapping environment some are less so 

because they are either implied in some fashion or are provided in some other 

way.  For example, the direction for North is almost always at the top of the map 

window and therefore it can be implied that this is true and the need to display 

an arrow is not necessary.  The one element of a legend that is most important in 

a digital environment is the legend key.  It is the legend key that helps you 

understand what each symbol, color and line represent. 

Geomatica LidarEngine provides access to the legend of each map layer by 

simply selecting a button from a tool bar.  This action opens a special legend 

window located inside the map window which will contain the legend.  You will 

see that you can easily change the contents of this window as well as add other 

legend windows. 

Opening a Legend 

To open the legend panel in a map window and add a legend to it, 

simply select the Legend button located on the toolbar in the map 

window.  When this is done the map window expands slightly and the 

legend window appears inside docked on the right hand side.   

By default Geomatica LidarEngine chooses to 

display the legend for the top layer in the Layer List.  

You can change what is displayed by selecting the 

dropdown list provided at the top of the legend 

window.  This dropdown will have a listing of all the 

layers in the map window. 

You can add the legend of another map layer by 

again selecting the Legend button.  This will split the 

legend window and display the legend for another 

map layer. 

The width of the legend window can be changed 

by moving your cursor to the left side of the window 
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so that your cursor changes to a “Move” cursor.  When this occurs 

simply click and drag the left side of the window to either the left or 

right. 

To remove the legend panel, click the close button (x) in the upper 

right corner of the legend window. 

Grid Legends 

The legend for grid layers will be displayed as a vertical bar of 

graduating colors emulating those used in the grid.  Each color 

interval is labeled and an extra color box is supplied to identify the 

exact color that is used for the interval.  Also supplied is the color used 

for the No Data value.  

Vector Legends 

Prior to displaying the legend for a vector map 

layer, Geomatica LidarEngine queries the map 

to determine how many different object types 

and styles are contained within the layer.  When 

this is determined, each different object type is 

displayed and labeled with respect to its type. 
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Preferences  

The Preference dialog controls several global settings that the application uses.  

These settings can be modified for just the current project or the application in 

general.  This dialog is accessed from the File menu on the main application 

menu bar. 

 

 

 

Map Window 

Back Ground Color – defines the color applied to the areas of the 

map window that is not occupied by map elements. 

Boundary Color – defines the color of the bounding box that encloses 

those objects currently selected. 

Selection Color – defines the color used to identify those objects that 

have been included in a selection. 

3D Window 

Back Ground Color – defines the color applied to the areas of the 3D 

window that is not occupied by map elements. 

Selected Layer Extent Color – defines the color of the 3D bounding 

box used to identify the layer selected in the Layer List. 

Texture Quality – defines the texture quality of the 3D rendering. 

Unselected Layer Extent Color - defines the color of the 3D bounding 

box used to identify the unselected layers in the Layer List. 
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Map Labels 

Transparent background – specifies whether the background color 

will be white (default) or transparent (invisible) 

Allow Overlapping Text – specifies whether labels will be allowed to 

overlap. 

Font – opens the Font Style dialog where the style of txt is chosen for 

all labels. 

Position – a series of nine toggle buttons which defines where the 

label will be placed with respect to the objects centroid. 

Label offset – specifies how far the label will be placed from the 

objects centroid.  Distance is specified in points.  

Rotate label with line – specifies that when a line objects are to be 

labeled then the label will be rotated with respect to the angle of the 

line. 

KML Export 

Angle View – defines the default viewing angle (aspect and 

inclination) that map layers will be viewed at inside Google Earth™. 

Vector data export – defines the threshold levels when vector map 

layers will be exported automatically to vector KML file or to a KML file 

associated with an image.  The minimum setting defines the number 

of objects under which Geomatica LidarEngine will automatically 

export to a vector KML file without warnings.  The maximum setting 

defines the number of objects over which Geomatica LidarEngine will 

automatically export to an image KML file with out warnings.  If the 

number of objects in a vector map layers falls between the minimum 

and maximum values then a warning will appear providing you with 

the option to proceed to export to a vector KML file or to an image 

KML file. 
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Chapter Chapter Chapter Chapter 4444    

 

Data Visualization 
 

Overview 
In the last chapter you learned about the relationship 

between map objects, the data associated with them, and 

how they are dynamically linked.  Because of this link, 

Geomatica LidarEngine can provide a number of ways to 

visualize this information on a map.  For example, labels can 

be applied to each object in a map layer that displays some 

information contained within the maps table.  Or the colors in 

an elevation grid can be modified, so that areas below sea 

level are shaded blue and the areas above sea level are 

green.   More sophisticated methods include rendering one or 

more map layers in a three dimensional view, and then being 

able to manipulate the viewing perspective of the scene. 

 

 

This chapter covers the following topics. 

 

• 3D Viewing 

• Contouring 

• Labeling 

• Grid Colorizer 

• Map Scales 

• Graticule Lines 

• Projections 
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3D Viewing 

The power of any digital mapping product can be measured in the number of 

ways it can change the perspective of a data set.  The more ways in which you 

can change this perspective increases the probability that something new will be 

revealed in the information.  One such way of changing the perspective of 

gridded information is to visualize it in a three dimensional view.   

 

Often what makes 3D visualization, of spatial information so appealing is that it 

presents information in away that our brain is used to experiencing it.  This is 

particularly true for terrain related data.   

 

The 3D Viewing component in Geomatica LidarEngine provides you with a 

number of sophisticated ways to visualize and manipulate map layers in a three 

dimension view.  Often this ability requires the presence of some sort of gridded 

information such as digital elevation model (DEM), but in Geomatica LidarEngine 

any map layer can be given a perspective view.   
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Creating a 3D view 

 

Creating a 3D view is a matter of toggling the map window from its 

two dimensional view to a three dimensional view by selecting the 

3D button located on the 3D toolbar.  Only the portion of the map 

that was visible in the map window will be rendered in 3D therefore 

make sure the extents of what you would like to see is visible in the 

window.  Remember that all visible layers whether they are grid or 

vector will be rendered in the 3D scene.  

When a grid is displayed in 3D, the 3D effect is generated by 

extruding each cell in the grid to the height of its z-value.   For 

vector map layers the same effect can not be applied due to the 

lack of height information associated with each object.  In this 

case vector map layers are displayed as a flat plane in a three 

dimension perspective. 

 

 

When a vector map layer is displayed in 3D it is 

rendered in a flat plane.  The image above has two 

vector layers and one grid layer. 

Layer List settings 

Once toggled over to the 3D view you will notice that each visible 

layer from the 2D view was rendered as a separate layer in the scene.  

The order in which they appear emulates the order they are in the 
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Layer List.  In fact there are other Layer List settings that also control 

aspects of the 3D window.  These settings include reordering layers, 

turning the visibility of a layer on and off, and removing a layer from 

the window 

Adding other map layers 

Adding a map layer to the 3D scene is no different than adding one 

to a regular map window.  All you have to do is select the desired 

map layer from the Project Manager and drag and drop it into the 

window.  As long as the selected map layer is geographically 

overlapped with the extents of the 3D scene it will be rendered. 

Selected layer 

When one of the layers in the Layer List is selected, it is reflected in the 

3D scene by an outline and a scale appearing around the selected 

layer.  For vector layers, the x and y-axis are labeled with the 

coordinate values to give you an idea of the distance along each 

edge of the map.  The values are derived from the projection system 

of the map and are place on the corners and mid point of each side. 

The same effect appears for grid layers except that this type of 

information also has a height or z-value that is represented.  If you do 

not want to see the scale on any of the layers, select the scratchpad 

layer in the Layer List. 

Navigating the 3D scene 

Geomatica LidarEngine provides you with many simple ways in which you can 

change the viewing perspective of the 3D scene.  What makes it easy is that you 

only have to know how to click and drag your mouse cursor within the 3D 

window.  Some of the viewing parameters that you have control over are; 

zooming in and out of the scene, and rotating the scene about a point.  This next 

section describes in more detail how you can manipulate all of the viewing 

parameters.  Each of these parameters can be accessed from the 3D toolbar 

located in the map window. 

Rotatation 

The scene can be rotated either horizontally or vertically depending 

on how you move your cursor within the 3D window.  To rotate the 

scene horizontally click inside the window and drag your cursor to the 

left and right.  To rotate the scene vertically click inside the window 

and drag your cursor up and down.  These two rotation methods do 
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not have to be performed independently of each other.  In fact you 

will quickly find out that you can rotate the scene in both directions at 

the same time and at oblique angles just by changing your cursor 

movement.  If scene rotation does not work check to see if the Pan 

button is engaged as this tool will disable the rotation feature. 

Zooming 

You can zoom-in and out on the scene by holding down the Control 

key while rolling the mouse wheel.  To zoom-in on the scene simply roll 

the mouse wheel away from you, to zoom-out roll the mouse wheel 

towards you.  Don’t forget to hold down the Control key when doing 

this.  If your fingers are nimble you will be able to rotate the scene and 

zoom-in and out at the same time. 

Panning 

The 3D scene can also be moved around the window without 

changing the viewing perspective.  This is done by holding down the 

Shift key, clicking inside the window and then dragging your cursor to 

another position.  Panning can also be performed by selecting the 

Pan button (hand) located on the Map View toolbar inside the map 

window.  When this tool is engaged you will not be able to rotate the 

scene as described earlier.  

Vertical exaggeration 

Vertical exaggeration is the degree in which the scene has been 

stretched in the vertical direction.  To increase the exaggeration 

simply roll the mouse wheel away from you.  To decrease it, roll the 

wheel back towards you.  

If your scene contains more than one grid layer then the 

exaggeration of each of these layers can be controlled individually 

by highlighting the desired layer in the Layer List.  Vector layers 

displayed in the scene will remain unaffected by this control. 

Layer spreading 

If you have more than one layer displayed in the 3D scene, then you 

can modify the vertical distance between the layers.  This is done by 

holding down the Alt key while rolling the mouse wheel.  To spread 

the layers farther apart roll the mouse wheel away from you.  To move 

the layers closer together roll the mouse wheel towards you. 
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Creating a Drape 

 
Draping is a way of merging vector layers with the grid identified 

as the Master Grid.  This is an effective way to visualize other 

mapping elements in a 3D view.  For example you can drape 

vector contour lines on a elevation grid or display the store’s 

location on a grid depicting trade areas. This feature can be 

turned on or off by selecting the Drape toggle button located on 

the 3D toolbar. 

Changing the Master layer 

 
Every map or 3D window that contains at least one grid file will 

have a Master grid layer.  This layer is identified in the Layer List 

with a mountain icon preceding the layer name.  By default the 

Master grid layer is always assigned to the first grid layer that was 

opened in the window.  It is this layer that is referenced when a 

drape is being performed.  

The master layer can be changed by highlighting another layer in 

the Layer List and selecting the Master Layer button located on 

the bottom of the panel window. 

Other viewing options 

There are a number of other viewing options that you can experiment with, that 

will change the display of the 3D scene. 

Wireframe 

 
The Wireframe mode changes the visual display of the 3D scene by 

rendering only the outline of each grid cell as apposed to 

rendering the entire face of the cell.  This mode affects all grid 

layers that are displayed in the scene.  This feature can be turned 

on or off by selecting the Wireframe toggle button located on the 

3D toolbar. 

 

Collapsing layers 

 
The Collapse option merges all grid layers in the 3D window to the 

Master layer.  De-selecting the collapse layers button will detach 

the layers so that they can be viewed separately. This feature can 

be turned on or off by selecting the Collapse toggle button 
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located on the 3D toolbar. 

 

Extents 

 
The Extents option places a gray outline around the extents of 

each grid layer in the scene. This feature can be turned on or off 

by selecting the Extents toggle button located on the 3D toolbar.  

If you are having trouble turning off the grey box try selecting the 

Scratchpad layer in the Layer List. 

 

Enable Markers 

 
The Enable Markers option places geographic coordinates along 

the x, y and z axis of the 3D scene.  This gives the viewer a sense of 

how large the geographic are is and to which degree the vertical 

axis is exaggerated.   
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Contouring 

The Contouring procedure in Geomatica LidarEngine analyzes raster grid 

formatted data and generates a vector representation of it.  Two types of 

representations can be specified, either contour lines or contour regions.   

 

When creating contour lines, a polyline is threaded through the grid at one or 

more user defined intervals.  These polylines join locations that have the same 

value, for this reason they are known more technically as isolines where “iso” is 

Greek for equal.   

 

For most people when they think of contours they think of elevation isolines shown 

on paper maps to depict the elevation, however contours can be created for 

any type of gridded data.  For example weather maps use contours all the time 

for showing themes like temperature (isotherms), barometric pressure (isobars), 

and rainfall (isohyets).  Other uses for contours can be applied to mapping 

population densities (isopleth) and even death rates (isomorbs). 

 

 

 

Geomatica LidarEngine also has the ability to generate contour regions.  The 

procedure for creating regions is technically the same, lines are threaded through 

the grid at user defined intervals. The difference being, that adjacent contour 

lines are connected in such away that a polygonal region is created that 

encompasses a range of values.  For example a temperature map is contoured 

at 10 and 20 degrees.  The corresponding region contour map would enclose a 

regions whose values all range from 10° to 20°.  In Geomatica LidarEngine 
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contour regions are created as complex objects where island and hole 

relationships are honored, in areas where values increase or decrease. 

 

When viewing a contour map you are able to draw several kinds of information 

from them.  Firstly you are able to estimate the value at any location on the map 

by looking at the value of the closest contour line.  Secondly you are able to 

estimate the rate of change in values by the closeness of the lines.  Contour lines 

that are closer together are showing a faster rate of change than those farther 

apart.  Lastly, you are also able to depict ridges and valleys by how the lines 

converge and diverge. 

 

Although contour regions are not as popular as line contours they can be quite 

useful.  Contour regions are good at providing a more generalized view of the 

surface data because they can have a color applied to them that represents the 

range of values.  Although this can be done on polyline contours, it is not as 

effective visually.  Also, contour regions make it easier to make geographical 

selections based on a range of values.  For example a city planning official can 

easily select properties that fall within the 70 to 75 dB noise contour centered 

around an airport when assessing building code compliance. 

 

Creating Contours 

The Contouring wizard is a three step process that can be accessed from either 

the Analytic Wizard menu in the main application window, the right click Analytic 

Wizard menu in the Project Manager, or from the Workbench panel window. 

In the first step you will identify the name and location of the folder where the 

results will be stored when processing is complete. In the second step you will 

choose which map layer to run the procedure and what kind on contours will be 

created.  In the third step you will define how the intervals will be created.  The 

settings for step three are described below. 

 

Step 3 Contour Interval Settings 

Start contouring at – defines the interval value at which the contours 

will begin to be created.  This value can not be lower than the lowest 

value in the grid. 
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Finish contouring at – defines the interval value at 

which the contours will finish.  This value can not 

be greater than the maximum value in the grid. 

Minimum grid value – displays the minimum value 

found in the grid. 

Maximum grid value – displays the maximum 

value found in the grid. 

Set interval size – defines the step size or the 

distance between each contour interval.  This 

option overrides the Set number of intervals 

setting. 

Set number of intervals – defines the number of 

intervals that will be created between the start 

and finish contour settings. This option overrides 

the Set interval size setting. 

Contour detail – a slider bar that defines from which pyramid level the 

grid contours will be generated.  Sliding the bar from left to right 

increases the detail in which the contours will exhibit, this also increase 

processing time. The number of tick marks along the slider bar 

corresponds to the number of pyramid levels.  This feature is 

unavailable in this version of Geomatica LidarEngine. 

Contour entire grid – specifies that the entire grid area will be 

processed for contours. 

Define area manually – specifies that you will define the area to 

contour from the Preview window. 
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Labeling 

Labeling is the process of annotating features on a map layer with information 

contained in the map’s table.  In Geomatica LidarEngine this is an automated 

process that saves you from manually entering the text, and because labels are 

linked to the table they are updated when the table is updated.   

 

 

Map of the United States, labeled with 

state names.  

 

The visibility of labels is controlled by checking or unchecking the Label check 

box in the Layer List.  Once checked, all map objects on the selected map layer 

are labeled according to the settings defined by the Label options dialog.  This 

dialog is accessed from the bottom of the Layer List. 
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Using the Label Options dialog 

The Label Options dialog is accessed by selecting the Label Options button 

located on the bottom of the Layer List window.  It is from this dialog that you will 

be able to control which information is used for the labels, how they look on the 

map and where they are located. 

In the Layer List be sure to select the map layer you wish, before opening the 

dialog.  The following describes the settings on this dialog. 

 

Label with – specifies which column 

in the table will be used to label 

each map object.  By default the 

first column is chosen.  

 

Transparent background – specifies 

whether the background color of 

the label will be white (the default) 

or transparent (invisible).  

 

Allow overlapping labels – specifies 

whether labels will be allowed to 

overlap.  When left unchecked 

Geomatica LidarEngine only labels 

some of the features on the map 

layer depending on how far you have zoomed-in or out.  The farther 

you zoom-in the more labels will be seen due to the extra space 

available for label placement. 

 

Font – opens the Font Style dialog where the style of text is chosen for 

the labels.  The font is not fixed to a scale and therefore, the text size 

will stay the same relative size to the computer screen, regardless of 

how far you zoom-in or out. 

 

Label position – a series of nine toggle buttons which defines where 

the label will be place with respect to the objects centroid. 
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Label offset – specifies how many pixels the label will be placed from 

the objects centroid. 

 

Rotate label with line – specifies that when line objects are being 

labeled, the label will be rotated with respect to the angle of the line. 
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Grid Colorizer 

The Grid Colorizer tool is designed specifically to modify the color used to depict 

the values in a numeric grid.  The tool edits the color profile that is saved with 

each grid and which contains a listing of inflection points with their associated 

color.  When the grid is opened, the profile is read and each cell is assigned a 

color based upon its value.  The dialog is divided into four different areas, the 

legend area, the Preview window, relief shading options and color profiles.  These 

three areas are discussed below. 

 

 

 

 

The Legend area 

This portion of the Grid Colorizer defines the color profile or color ramp that is used 

to depict the grid.  There are two elements associated with this area, the color 

ramp with a slider bar representing each inflection point, and the legend 

displaying the color and value of each inflection point. 

Moving an existing inflection point 

An existing inflection point can be moved in two ways.  First, you can 

select the slider bar on the color ramp and drag it either up or down.  

Legend area 
Preview window 

Relief shading 

settings Color profile 
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You will notice that the color gradient changes as the slider bar is 

moved.  Slider bar movement is restricted by the location of adjacent 

inflection points.  The second way is to manually edit the value the 

inflection point represents.  This is done by double clicking on the 

value displayed next to the color ramp.  When this is done a dialog 

will open where you can enter the new value. 

 

 

 

Adding an inflection point 

An inflection point can be added by selecting the “+” button.  The 

new inflection point will always be inserted above the active 

inflection point and halfway between the adjacent one.  The color for 

the new inflection point will be estimated from the colors of the 

adjacent inflection points.  Geomatica LidarEngine is limited to 16 

inflections 

Removing an inflection point 

Any inflection point can be removed by first selecting the one to be 

deleted, and then clicking the “-” button.   

Changing the color of an inflection point 

The color that the inflection point represented in the grid can be 

modified by double clicking on the color box located beside the 

inflection value.  When this is done a dialog will appear from which 

Drag inflection point 

up or down 

Double click to change 

inflection value. 

Double click to change 

inflection color. 

Add an inflection 

point or delete the 

selected one. 
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the color can be defined.  The dialog will allow you to choose from a 

custom palette or define a color manually by entering RGB values or 

HSV values. 

 

The Preview Window 

The Preview window, located on the right side of 

the Colorizer dialog, automatically updates 

whenever a change is made to the color 

settings. 

To get a better idea of how the grid will look 

when changing the colors you can zoom-in on 

different areas of the map by selecting the 

Zoom In/Out buttons located on the right side of 

the window.  To view the entire grid area select 

the View To Full Extent button. 

The display o the grid inside the preview window can also be modified by turning 

on relief shading or a 3D perspective.  When relief shading is turned on then 

additional settings become available on the Colorizer dialog. 

 

Relief shading  

In addition to assigning a color gradient to a grid, the Grid Colorizer tool also 

calculates relief shading.  These settings are located on the two tabs at the 

bottom left of the Grid Colorizer dialog.  Relief shading introduces an imaginary 

light source into the scene and calculates where the shadows would fall given 

the variation in the grid surface.  This calculation is then incorporated into the 

color profile that assigns the color for each cell.  Although relief shading can be 

applied to any numeric grid it is most effective when applied to elevation data.  

When applied, the shadows highlight where the variation or the relief is in the grid 

surface producing a three dimensional effect.  Geomatica LidarEngine provides 

two methods for controlling the Sun’s position.  The more traditional method is to 

simply enter azimuth and inclination angles which can be performed on the 

Azimuth/Inclination tab.  The second method is to enter the date and time you 

are interested. This can be done on the Shade by Time tab. 

Azimuth / Inclination Tab 

The Azimuth and Inclination settings define the location of the 

imaginary light source with respect to the grid.  It should be noted 

that the distance the grid is from the light source is not computed, it is 
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simply assumed that the distance is quite large, such as the distance 

from the Sun to the Earth. 

 

Azimuth – defines the compass direction the light source is oriented, 

North, South, East or West.  This setting can be modified by manually 

entering the desired azimuth value into the provided edit box.  If you 

are unsure of what this value should be then you can click on the Sun 

icon in the compass graphic provided and drag it to the desired 

orientation.   Both the azimuth value and the Preview window will 

automatically update as the Sun icon travels around the compass.  

Although the light source can be positioned in any direction, 

generally the most effective looking renderings have the sun located 

in the West or the East. 

 

 

 

Inclination – defines in degrees how far off the horizon the light source 

is oriented. The setting can be modified by manually entering the 

desired inclination value into the provided edit box.  If you are unsure 

of what value to enter click on the Sun icon in the graphic provided 

and drag it to the desired orientation.  Both the inclination value and 

the Preview window will automatically update as the Sun travels from 

left to right 

Enable – a check box that specifies that relief shading of the grid will 

be performed using the settings on the Azimuth / Inclination tab. 

 

Shade by Time Tab 

The azimuth and inclination of the Sun can also be defined by the 

time of day and calendar date.  Any changes to these settings will 

automatically be reflected in the preview window. 
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Time – an edit box defining the position of the Sun by the time of day.  

The edit box is divided into four sections, one for each time 

component, hour, minute, seconds and AM/PM.  Each of these 

sections are edited independently by typing in a value using the 

keyboard or by using the provided arrow buttons.  The Time can also 

be modified using the provided blue clock graphic.  Simply select the 

Sun icon a drag it to a new position of the clock.  The Time edit box 

will automatically update with the time.  

 

 

Date – an edit box defining the position of the Sun by the calendar 

date. The edit box is divided into three sections, one for each date 

component, day, month, and year.  Each of these sections can be 

edited independently by typing in a value using the keyboard.  A 

more graphical date choosing tool can be accessed by selecting the 

drop down arrow to the right of the edit box as shown above. 

 

Enable – a check box that specifies that relief shading of the grid will 

be performed using the settings on the Shade by Time tab. 

Z-Scaling 

Located below the Preview window is the Z Scale setting.  This setting 

artificially increases or decreases the vertical exaggeration of each 

grid cell when relief shading is calculated.  The effect that this has on 

the display of the grid is that the shadows will become darker and 
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more pronounced when increased, and lighter or more faded when 

decreased.  

 

Layer Transparency 

A level of transparency can be applied to the grid the degree of 

which is displayed in the Transparency edit box located below the 

preview window.  Transparency is expressed as a percentage where 

a value of zero indicates that no transparency has been applied and 

a value of 100 indicates the layer is invisible. 

The transparency level can be modified in two ways.  The first is to 

place your cursor in the edit box where the transparency value is 

displayed and simply enter in a new value.  The second is to select 

the dropdown arrow located to the right of transparency value.  

When the slider bar appears move it to the left and right to change 

the transparency level.  

 

 

Color Profiles 

A color profile is simply a ASCII text file with an .icp extension which 

contains a description of how a grid should be colored.  In its basic 

form it stores only the color and z-value for each inflection point in the 

profile.  Profiles are an extremely convenient way of apply the same 

color scheme to multiple grids as it eliminates having to manually 

changing each one.  This is especially important when you have 

several grids that are adjacent to each other and it is necessary to 

color them the same way so that their edges are not visible. 

The controls in the color profile section of the Colorizer dialog allow 

you to load in an existing profile, save the current color configuration 

to a profile, and normalize a profile to the current grid.  If a profile has 

been applied to the grid then the name of this profile will be 

displayed.  

 

Save – a command button that allows you to save the current color 

scheme to a profile .icp file. 
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Load – a command button that allows you to open an existing color 

profile. 

Normalize profile – a checkbox which spreads the values in the 

specified profile across the value range of the grid.  This setting is only 

available when a profile has been loaded.   

The Normalize Profile feature is typically used when the value range of 

the profile does not match the range of the grid.  For example, you 

want to apply a visually appealing color profile to a grid that has a 

value range between 50 and 100, but the profile has a range 

between 0 and 500.  Without normalizing the grid will only display a 

small portion of colors (50 and 100) from the profile.  When the 

Normalize Profile setting is engaged the color inflection points are 

spread proportionally across the range of the grid. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Geomatica LidarEngine User Guide                           103          

 Chapter  Chapter  Chapter  Chapter 5555    

 

Data Processing 

 

Overview 
Many of the features described in this chapter allow you to 

manipulate map layers or the data within them.  Typically this 

is necessary to make a layer more suitable for display or to 

prepare it for further analysis.   

 

For example the Grid Trimmer enables you to trim out an area 

of a larger grid which can help decrease processing time for 

some solvers such as the Watershed Analysis. 

  

This chapter covers the following topics. 

 

• Point Aggregation 

• Point Collocation 

• Grid Trimmer 

• Grid Resizer 

• Grid Smoothing 

• Grid Splicer 

• Image Registration 

• Gap Filler 

• Map Object Creation 
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Point Aggregation 

The purpose of the Point Aggregation solver is to reduce the number of points 

contained within the map in a manner that is mathematically and spatially 

appropriate.  It does this by first selecting groups of points from around the map 

that would fall within a user defined search radius.  For each group the 

geographic center is determined and a new data point is inserted at this 

location. The final step is to attribute the new data point with an aggregated 

value based upon the points in the group.  Several calculations are performed, 

and the default calculates the average value. 

  

Point Aggregation is almost always used to prepare a point data set for other 

types of analysis such as interpolating a grid surface.  For example, if you had a 

densely clustered dataset of elevation points on which you wanted to perform a 

TIN based interpolator, it is likely that you would want to aggregate the data set 

so that the points are more spread out.  This is because a densely clustered point 

file will produce unwanted artifacts in the grid produced by the TIN interpolator.  

This aggregation method was designed to be a general use aggregation method 

and therefore will be appropriate for most of your needs.   

 

Why Aggregate 

There could be many reasons why you would want to aggregate a point data 

set.  Listed below are the top four that you will likely encounter. 

1. There are multiple data points at a single location and it is only 

necessary to display one and you want to retain representative 

value. 

2. There are too many points in the original data set to permit efficient 

processing. 

3. There are outliers in the data set that would skew any further 

analysis and therefore should be smoothed or averaged out with 

neighboring sample points. 

4. The distribution of the points is such that it is not appropriate for 

some interpolation methods. Aggregating the data would 

distribute the points more evenly across the study area. 
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Why not just delete points? 

One way to reduce the number of points in a point file is to simply go 

to the table or map and delete some records. Unfortunately there are 

a number of problems associated with this approach. 

When deleting records from the table there is no accounting for the 

spatial distribution of the points.  For example, by selecting a group of 

records it is difficult to know where they are on the map and therefore 

there is a possibility that they are located in the same geographic 

area.  Having a number of points deleted from the same location is 

not the ideal.  The best solution would be to remove points from 

different locations around the map. 

By selecting records from the map there is a certain amount of 

control over the spatial distribution of the points being deleted, 

however this can be a time consuming process especially with large 

datasets. 

With either of these approaches there is a loss of information when 

the record is removed. The most appropriate solution would be to 

mathematically merged the data from the deleted records with the 

records that remain. 

 

Using Point Aggregation 

Point Aggregation is a three step wizard that can be accessed from either the 

AiQuipment menu in the main application window, the right click Solver menu in 

the Project Manager, or from the Workbench panel window. 

In the first step of the wizard you will identify the name and location of the folder 

where the results will be stored. In the second step you will choose on which map 

layer to run the procedure, and which column in the point file will be 

aggregated.   The third step contains more settings that affect the results of the 

aggregation.  The settings for step three are described below. 

 

Step 3 -  Aggregation settings 

Aggregation method – defines the method which is used to group 

points for aggregation.  Only the Simple Point method is available. 
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Calculation – refers to which mathematical operation will be 

performed on the points selected to be aggregated.  Six different 

choices are provided, the default is average. 

 

Aggregation distance – defines the circular 

area that will be used to select data points for 

aggregation.  It can be thought of as the 

distance at which points will be considered to 

be coincident.  In the resulting map no two 

points will closer than this distance.   
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Point Collocation 

The Point Collocation solver employs a specialized aggregation technique that 

simply deletes one or more points that are considered to be coincident.  It begins 

by inspecting each point in the map layer starting with the first record in the table 

and finishes with the last record in the table.  When each point is inspected, a 

search radius is constructed from which all other points in the map layer are 

select and deleted.  From the remaining points in the map the next highest 

record in the table is identified and the process repeats. 

This is known as a blind aggregation method, as it simply deletes records without 

any merging of data value.  It is most often used when there are known 

coincident points and the retention of attribute data is not important. 

 

Using Point Collocation 

Collocation is a three step wizard that can be accessed from either the 

AiQuipment menu in the main application window, the right click Solver menu in 

the Project Manager, or from the Workbench panel window. 

In the first step of the wizard you will identify the name and location of the folder 

where the results will be stored. In the second step you will choose on which map 

layer to run the procedure, and which column in the point file will be 

aggregated.  In the third step you will simply specify the aggregation distance. 

 

Step 3 -  Aggregation settings 

Aggregation distance – defines the circular 

area that will be used to select data points for 

aggregation.  It can be thought of as the 

distance at which points will be considered to 

be coincident.  In the resulting map no two 

points will closer than this distance.   
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Grid Trimmer 

The Grid Trimmer provides you a means of cutting out a smaller area of a larger 

grid.  There are many reasons for doing this however typically it is done because 

the area of interest is small and managing a larger grid can be cumbersome.  For 

example the processing time for some Solvers is directly related to file size, the 

larger the file the longer it takes to produce a result.  Also, sharing your project 

with others can be more difficult if you have large files.  Trimming your grid files to 

the extents of your study area is a way of reducing their size. 

 

Using Grid Trimmer 

The Grid Trimmer solver is a four step wizard that can be accessed from either the 

AiQuipment menu in the main application window, the right click Solver menu in 

the Project Manager, or from the Workbench panel window. 

The first step of the wizard identifies the name and location of the folder where 

the results will be stored.  The second step identifies which grid file in the project 

will be used to trim.  The third defines the area that will be trimmed, and the fourth 

step simply provides a preview of the results. 

 

Step 3 – Grid Trimmer settings 

In the third step of the wizard the area of the grid that will be trimmed 

out is identified. By default the trim area is maximized to the extents of 

the input grid and is automatically displayed in the preview window 

as a yellow outline. 
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The trim area can be modified by selecting one of the corner nodes 

and dragging it to a new location.  Also, the entire trim area can be 

moved around the preview window by clicking in the middle of the 

region and dragging it to a new location.   

The dialog also provides you with the coordinate values of each of 

the four corners.  These values can be manually edited with more 

precise values.  The coordinate values reflect the coordinate units 

specified by the projection of the map file.  

 

Step 4 – Grid Trimmer preview 

In step four of the wizard a preview of the results is displayed.  If the 

results are not what you are expecting simply select the Back button 

and redefine the trim area. 
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Grid Resizer 

Grid Resizer increases or decreases the size of the grid cell used to portray the 

values in the grid.  Essentially it mathematically modifies the resolution by merging 

grid values when increasing the cell size and extrapolating new cell values when 

decreasing the cell size.  It is important to note that Geomatica LidarEngine does 

not modify the input grid, it creates a new one with the modified cell size. 

The resizing operation is generally used to reduce the resolution of grid to permit 

more efficient processing for some solvers.  This is only appropriate when the 

reduced resolution will not adversely affect the final results.    

An example of when you would want to increase the resolution would be when 

trying to drape a high resolution satellite image onto a lower resolution elevation 

grid.  The drape function in the 3D feature is dependant on the grid in which it is 

being draped.  In this situation the satellite image will not look as good as it could 

because its resolution has been sampled down to that of the elevation grid.  By 

using the Grid Resizer to increase the resolution of grid you will make the drape of 

the satellite image look much clearer. 

Here are some things to remember when resizing a grid. When increasing the cell 

size you are decreasing the resolution of the grid and making the output file size 

smaller than the original. Essentially you are mathematically and spatially merging 

cells and their values together and in effect losing accuracy in comparison to the 

input grid.  When decreasing the cell size you are increasing the resolution.  It is 

important to note that even though you are increasing the resolution you are not 

making the grid more accurate you are simply spreading the known values 

across more cells. 

If you would like to resize only an area of an input grid, then initiate this solver from 

the Grid to Grid wizard.  This wizard includes a masking ability that provides for 

defining an area that will be processed.  The masking procedure in effect is the 

same as trimming a grid to a boundary and then resizing the results. 

Using Grid Resizer 

The Grid Resizer solver is a three step wizard that can be accessed from either the 

AiQuipment menu in the main application window, the right click Solver menu in 

the Project Manager, or from the Workbench panel window. 

The first step of the wizard identifies the name and location of the folder where 

the results will be stored.  The second step identifies which grid file in the project 

will be trimmed.  The selected file is applied to the Preview window. 

The third step has but one setting which is the new cell size.  The default is the cell 

size of the input grid.  The units are defined by the projection of the input grid.  
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Grid Smoothing 

The Grid Smoothing solver is a filter whose main function is to reduce the 

variability in a grid by averaging cell values contained in a specified area.  As the 

name implies the solver can only be applied to raster data files.  In general there 

two types of filters.  The first are averaging or low pass filters that are good for 

smoothing the variation of cell values found in a grid.  The second are edge 

detection or high pass filters, these are typically used for enhancing edges and 

sharpening images. 

 

The basic principal of either type is to pass a window (3x3 or 5x5 pixels) through 

the raster grid calculating the average value of all pixels inside the window, and 

assigning this value to the center pixel in the window.  For high pass filters there is 

a degree of weighting applied to certain pixels within the window that result in 

emphasizing the edges in the grid.  In either case the size of the window has an 

impact on the results, for example a greater degree of smoothing will result when 

using a large window size for a low pass filter.   

 

In terms of their application, low pass filters are used on any raster data structure, 

either images or grids.  On the other hand high pass filters are generally used on 

raster imagery such as satellite and aerial photography. This version of 

Geomatica LidarEngine only includes the more popular Low pass or averaging 

filter. 

 

If you would like the smooth only an area of an input grid, then initiate this solver 

from the Grid to Grid wizard.  This wizard includes a masking ability that provides 

for defining an area that will be processed.  The masking procedure in effect is 

the same as trimming a grid to a boundary and then smoothing the results. 

 

Using Grid Smoothing 

The Grid Smoothing solver is a two step wizard that can be accessed from either 

the AiQuipment menu in the main application window, the right click Solver 

menu in the Project Manager, or from the Workbench panel window. This solver 

automatically runs on the upper most layer of the current map window.  To avoid 

confusion run the solver from the Project Manager or open a map window that 

contains only the input data set. 
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The first step of the wizard identifies the name and location of the folder where 

the results will be stored.  The second step contains the settings for the Smoothing 

solver. 

Step 2 – Smoothing settings 

Smoothing window size – defines the size of 

the moving window that is used to average 

grid cell values.  The value entered is the 

number of rows or columns that surround the 

center cell.  For example, a value of 1 

specifies a 3x3 moving window, a value of 2 is 

a 5x5 moving window, and a value of 3 is a 

7x7 moving window. 

 

Weighting of center point – controls the 

intensity of the averaging algorithm.  This is 

done by weighting the center cell before 

calculating the average value for the window.  

The net effect upon the results are that, the 

higher the weight on the center pixel the lighter (less intense) the 

averaging or the smaller degree of smoothing is obtained.   

 

The weight of center calculation is as follows. 

(P1 + P2 + P3 + P4 + (CP5*w) + P6 + P7 + P8 + P9)/(8+w)  

Where P1…Px are the pixel values within the window, CPx is the value 

of the center pixel, and w is the weighting factor 

The following table provides an example of what can be expected 

from weighting using a 3x3 moving window. 

 

 Weigh

t 

Calculation Value 

1 (5 + 8 + 11 + 2 + (6*1) + 10 + 4 + 7 + 9)/(8+1) 6.8 

10 (5 + 8 + 11 + 2 + (6*10) + 10 + 4 + 7 + 9)/(8+10) 6.4 

5 8 11 

2 6 10 

4 7 9 100 (5 + 8 + 11 + 2 + (6*100) + 10 + 4 + 7 + 9)/(8+100) 6.02 
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Grid Splicer 

The Grid Splicer solver combines multiple grid tiles into one contiguous grid.  It is 

most often used to combine elevation grid tiles together so that a larger area is 

covered.  The advantage to doing this is that it can be easier to manage a single 

grid than many smaller ones.  An example where this is true, is when changing the 

colors used to portray the grid.  If there are many grid tiles covering your study 

area, the color profile for each tile would have to be modified separately.  If 

these tiles were combined into a single map layer, the colors would only have to 

be adjusted once.  Fortunately, Geomatica LidarEngine is designed to handle 

large grid files, and there is no performance lost when creating very large files. 

 

Two types of operations can be performed, merging and stamping.  The main 

difference between the two is the calculation that is performed on the areas of 

the input grids that overlap.  When merging grids, a mathematical calculation is 

performed on grid cells located in the overlapping areas.  Several different 

calculations can be applied; they include the average, minimum, maximum and 

median values from all input grids.  Due to the nature of the merge calculations 

the process order for type of operation is not important.  When stamping, grid cell 

values from one input layer are overwritten by grid cell values of another input 

layer.  Because cell values are being overwritten, it is extremely important in a 

stamp operation to have control over the process order.  In Geomatica 

LidarEngine, this is done by changing the order in which the layers appear in the 

process list. 

 

Using Grid Splicer 

The Grid Splicer solver is a three step wizard that can be accessed from either the 

AiQuipment menu in the main application window, the right click Solver menu in 

the Project Manager, or from the Workbench panel window. 

The first step of the wizard identifies the name and location of the folder where 

the results will be stored.  The next two steps are described below. 
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Step 2 – Layer selection 

In Step 2 all of the input data layers that will be spliced together are 

identified by selecting them from the project list.  Once these map 

layers have been selected, they automatically appear in the 

preview window in a wireframe rendering.  The wireframe is simply a 

box defining the extents of each input grid and will provide you with 

a good idea to the degree of overlay the layers have. 

 

 

Step 3 – Grid Splicer settings 

The basic function of Step 3 of the wizard, is to 

specify the type of operation (stamp or 

merge) and to define the process order.  A 

number of other settings are also defined 

which are described below. 

 

Process order – a table defining the order in 

which grid layers will be processed.  

Processing always begins with the first layer in 

the list and finishes with the last one.  The 

process order is only important if a Stamp 

operation is being performed.  In this instance 

the top grid is stamped on the second, the 
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results are then stamped onto the third etc.  The process order can be 

changed by selecting a layer and then clicking either the Up or Down 

button.  The selected layer is the one marked by the arrow on the left 

of the table. 

The table includes two columns labeled “Cell” and “Prj”.  The graphic 

displayed in these columns simply notifies you that some additional 

process may be required.  When the red “x’ appears it means that 

the layer has a different cell size or projection than specified by the 

output parameters, and will require preprocessing before the splice 

operation can begin. When the green check mark appears then the 

grid has the same cell size or projection as the output parameters and 

therefore no additional processing is needed. 

 

Overlap operation – specifies what mathematical operation is 

performed on grid cells from different map layers that geographically 

overlap. Four different calculations are provided for the merge 

operation, they include average, minimum, maximum and median.  

Only one type calculation is possible for the stamp operation.  The 

default is the Merge – Average operation. 

 

Cell Size – defines the size of the grid cell of the resulting spliced grid.  

By default it is the same as the input grid with the finest resolution.  

 

Projection – specifies the projection system that will be used for the 

resulting spliced grid.  By default it displays the projection system of 

the first grid listed in the process order table. The dropdown will list the 

projection systems of all the map layers included in the operation. 

 

Set projection – this button provides a means of defining the 

projection type of the resulting grid to something other than ones 

used by the input grids. 
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Image Registration 

One way of enhancing the look of a map window is to display some kind raster 

imagery in the back ground of the other spatial data being displayed.  For 

example, an aerial photograph or satellite image could be as a back drop for a 

street network file.  This provides the viewer much more information that is not 

available in the vector file such as what is in the areas between roads, how large 

buildings are, and how many spaces are in a parking lot. 

Although adding raster imagery is effective, unfortunately most available images 

are not geo-referenced or registered in geographic space.  This simply means 

that the software has no way of knowing where to position the image on the 

Earth’s surface.  When this situation occurs you will have to apply the geo-

referencing information to the image using the Image Registration utility. 

Image registration is the process of assigning x,y coordinates of several known 

locations on the image (control points).  Once these have been identified 

Geomatica LidarEngine performs the necessary transformations to fit the image 

to coordinates provided. The transformation can involve several movements of 

the image such as stretching it in either the x or y direction, shifting it in x and y 

directions, and a rotating.  Once this procedure is performed the registration 

information is saved to the image file so that next time it is opened it can 

immediately be used for mapping purposes. 

 

Using Image Registration 

The main step in registering an image is the selection of control points.  A control 

point is simply a location that has known x, y coordinates and can easily be seen 

on the raster image.  Typically road intersections are used for control points 

however it does not matter what you use as long as you can easily find it on the 

image.  The easiest way to determine the x,y coordinates of control points is to 

open a vector map of the same area such as street network file and then using 

the coordinate readout in the bottom right corner of the Geomatica LidarEngine 

window noting the coordinates of each chosen control point location.  Prior to 

launching the registration wizard the location of all control points must be known.  

 

Geomatica LidarEngine uses an affine transformation method which performs 

best with three or more control points.  For best results it is recommended that 

these control points be located near the outer margins of the image and should 

not be clustered in one location or lined up in a straight line.  It should also be 

noted that an affine transformation is performed to best fit the image into 
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geographic space and that Geomatica LidarEngine will not orthorectify the 

image to remove distortions introduced when the image was taken. 

 

The Image Registration solver is a three step wizard that can be accessed from 

either the AiQuipment menu in the main application window, the right click Solver 

menu in the Project Manager, or from the Workbench panel window.  The menu 

item that launches this solver is called Georeferencing Raster. 

The first step of the wizard identifies the name and location of the folder where 

the results will be stored.  The second step identifies the image that will be 

georeferenced.  The third step is described below. 

Step 3 – Select Control Points 

In Step 3 of the wizard the control points are selected from the map 

and coordinate values are entered.  

 

Using the Zoom-in/out and pan tools 

locate the first control point on the 

image.  To insert a control point select 

the Add Point tool located on the left 

side of the preview window and click on 

the map.  A large red plus sign will 

appear at this location and row in the 

Coordinate Display window will be 

inserted.  

To move a control point to a new 

location first select it using the Select tool 

and then drag it to its new location. 

To delete a control point, first select it using the Select tool and then 

click the delete button. 

 

When a control point is added the Coordinate Display window is 

updated with the new point.  By default the pixel location of the 

control point is populated in both the Raster X , Y columns and the 

Map X, Y columns.  Once a control point has been entered then 

place your cursor in the Map X and Map Y columns and enter the 

known geographic x,y coordinate previously determined. 
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The following is a description of the settings on 

this dialog. 

Raster X and Raster Y – two columns in the 

Coordinate Display table that shows the pixel 

location on the raster image for each control 

point. 

 

Map X and Map Y – two columns in the 

Coordinate Display table that shows the 

coordinate location of the control point.  By 

default the pixel location is initially entered.  

The user enters the known coordinate values 

previously determined. 

Residual – a column in the Coordinate Display 

table that displays the distance between the entered coordinate 

values of the control points and the calculated best fit values after 

the transformation.  The units of these values are defined by the 

distance units of the selected projection system.  A large residual 

value can be the result of an improper projection system, poorly 

placed control points, or incorrect coordinate values for the control 

points. 

 

Target Projections – a command button that opens the Reproject 

dialog from which the projection system of the image is chosen. 

 

Total RMS error – static text that displays the root mean square of 

deviations between the controls points and their pixel location on the 

image. 

 

Map units – a drop down list of the possible units that can be used.  

The list is generated using the chosen projection system. 

 

Interpolation method – a drop down list displaying the available 

interpolation methods which determine the new value of each 

transformed pixel.  Only one transformation method is currently 

available. 
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Transformation – a dropdown listing the transformation method that 

will be used.  Currently there is only one method available. 

 

Cell size – an edit box that displays the geographic size of each raster 

cell (pixel) in the image.  By default this value is calculated based 

upon the provided control points. 

 

Open results – a check box that specifies that the results will be 

opened into a map window when registration is complete. 
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Gap Filler 

The Gap Filler solver identifies all Null valued cells in an input grid and calculates 

an appropriate value for each using the values from the surrounding cells.  Gap 

Filler uses an averaging technique that uses sliding window that defines which 

surrounding cells will be used to calculate the new grid cell value.   

This solver is particularly useful on grids produced by the IDW interpolation 

technique.  One method of optimizing the processing time for IDW is to reduce 

the size of the search radius.  As a result some areas may not be interpolated 

because no points are found with in the specified distance and therefore are 

given a value of Null.  In some instances having many Null area with in the grid is 

not desirable and therefore need to be removed. 

 

Using Gap Filler 

Gap Filler is a four step wizard that can be accessed from either the AiQuipment 

menu in the main application window, the right click Solver menu in the Project 

Manager, or from the Workbench panel window. 

In the first step of the wizard you will identify the name and location of the folder 

where the results will be stored. In the second step you will choose on which map 

layer to run the procedure.  In the third step you will specify the bounding box 

that defines the geographic area that the Gap Filler solver will bee applied to.  

Specifying this bounding box can be done by either specifying the coordinates of 

the upper left and bottom right corners or by interactively editing the box that 

appears in the preview window. 

 

Step 4 – Choose window size 

Smoothing window size – a drop down list that 

defines the size of the sliding window used to 

calculate the new value for each Null valued 

cell. By default the window size is 3 x 3 cells. 
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Map Object Creation 

Editing map objects can be done to any of the point, line and region map layers.  

It can be useful to update and add new information or remove objects from map 

layers.  In order to begin editing, the layer must be made editable by selecting 

the check box in the Layer List. Only one layer can be made editable at any 

given time.  You will notice the Editor toolbar is enabled for the map layer that is 

selected.  As the map layer is edited, the dynamic link with the table means 

every change made to the map layer will be instantly updated.  

Selecting Tool 

Once in edit mode, any object in the editable layer can be selected.  

When selected, the object will be highlighted, outlined and the 

extent box of the shape will appear.  An object can be selected 

individually, or multiple objects can be selected by dragging the 

selecting box around several objects.  All the selected objects can be 

edited at the same time. 

 

Node Editor 

The nodes of any object become visible and highlighted by selecting 

the object in the editable map layer.  The nodes can be moved by 

clicking and dragging them, or can be deleted by selecting a delete 

tool from the toolbar.  A new node can be added by clicking the 

cursor anywhere on the objects boundary where a node does not 

already exist.  

 

Adding a Point 

Adding a point to the editable layer is done using the Add Point tool.  

As points are added to the editable layer, the browser is 

automatically updated with its information.  Each point is an 

individual object. 

 

Adding Multiple Points 

Several points belonging to the same object can be added using the 

Add Multipoint tool.  The points are placed individually by clicking the 

left mouse button and the last point is placed using the right mouse 
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button.  The points are grouped together and when one is selected, 

all become editable.  All the points only represent one record in the 

browser. 

 

Add a Polyline 

A polyline is a line made of segments which all belong to the same 

shape and only represents one object in the browser. Click the left 

mouse button once to begin the line and every time a node should 

be placed.  To end the line, use the right mouse button to place the 

final node. 

 

Add a Region 

A region can be added to the editable layer using the Add Region 

tool.  Click the left mouse button once to make the first point of the 

region and click again to add the boundary nodes.  To finish the 

region, use the right mouse button to place the final node and the 

region will close. 

 

Delete Object 

To delete an object, first select it and then press the Delete Object 

button.  The objects will be instantly deleted from the browser. 
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Chapte r  6  

 
Terrain Analysis 

 

Overview 
It is remarkable how much the terrain around us affects our 

every day life.  Something as insignificant as a hill can have a 

big impact, for example, it can make your bike ride into work 

each day very difficult.  Given enough precipitation this same 

hill could be the source of land slides that can be extremely 

destructive to commercial or residential properties. 

 

Engineers face questions that involve terrain variability all the 

time.  Often they are asked to answer questions like are two 

transmission towers in a microwave link visually connected? 

When building a road what is the least expensive route?  

Where will water start flowing when large amounts of rain are 

received?  This chapter contains a number of analytical 

techniques that are designed to quantify or describe 

characteristics about the Earth’s terrain.  Many of these can 

be used to answers some of the above questions. 

 

 

Topics covered. 

• Slope 

• Aspect 

• Viewshed Analysis 

• Terrain Variability 
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Slope 

The Slope function analyzes an elevation grid and calculates the slope of each 

cell, and stores the result in a new grid file.  The calculation involves averaging the 

rate of change between the target cell and each of its eight neighbors. 

A slope grid is beneficial in a number of ways.  Firstly, it allows you to easily see 

where the terrain is flat or steep just by looking at the map.  Secondly, although 

contours can provide this same information a slope grid quantifies the steepness 

with a value.  Essentially the flatter the terrain the lower the grid value, the steeper 

the terrain the higher the grid value. 

 

   

Original terrain grid.  Derived slope grid from elevation. 

 

Knowing the slope of the terrain becomes very important in many environmental 

applications. For example it is required for measuring the erosion potential of an 

area, or estimating snow accumulation.  It is also required for engineering 

problems such as defining suitable building locations in mountainous regions or 

determining the cheapest route for a new highway. 

 

When you create a slope grid, you are able to choose how steepness is 

expressed.  Your choices are either as a degree of slope or as a percent of slope. 

If you choose degrees then AiQ calculates the angle created from the change in 

elevation between two grid cells (rise) and the distance between two grid cells 

(run).  

• Degree Calculation Tan θ = rise/run 

• Percent Calculation = (rise/run) *100 
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If you choose percent, then AiQ takes the change of elevation (rise) and divides 

it by the distance between cells (run) and multiplies it by 100 to get a percent.  

You will notice that when the rise and the run are equal, a 45° slope is produced 

which is equal to 100% slope.  For steeper slopes the percent value gets quite 

large, it actually approaches infinity. 

 

Slope in Degrees Slope in Percent 

10° 17% 

45° 100% 

80° 567% 

 

Using Slope 

The slope solver is a three step wizard that can be accessed from either the 

AiQuipment menu in the main application window, the right click Solver menu in 

the Project Manager, or from the Workbench panel window. 

In the first step of the wizard you will identify the name and location of the folder 

where the results will be stored.  In the second step, you will choose from the 

project which grid to run the procedure on.  This step is skipped if you launch the 

solver from the Project Manager or the AiQuipment menu. In the third step, the 

slope calculation method is defined, as described below. 

Step 3 – Slope settings 

Slope calculation – a dropdown list specifying 

what type of calculation will be used to 

define slope.  Three different calculations are 

provided Degrees, Percent and Radians. 

Output information – this area provides some 

general statistics about the resulting grid 

surface such as the grid extents and the 

dimensions. 

Actions – These are standard settings that 

help you move through the wizard, open and 

close the Preview window and apply 

changes to it. 
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The Slope solver has also been included in the Grid-to-Grid wizard.  The main 

benefit to using the Grid-to-Grid wizard is that it allows you to perform the analysis 

within a masked area.  In other words it allows you to choose a rectangular area 

upon which the Slope calculation will be performed. 

Aspect 

The Aspect function analyzes elevation grids and calculates the direction each 

cell is facing and stores the results in a new grid.  The direction is expressed in 

degrees from North, therefore values will range from 0° (North) through to 360° 

(also due North). 

 

   

Original terrain grid.  Derived aspect grid from elevation. 

 

Using the Aspect solver 

The Aspect solver is a three step wizard that provides a preview of the results. The 

solver can be accessed from either the AiQuipment menu in the main 

application window, the right click Solver menu in the Project Manager, or from 

the Workbench panel window. 

In the first step of the wizard you will identify the name and location of the folder 

where the results will be stored.  In the second step you will choose from the 

project which grid to run the procedure on.  This step is skipped if you launch the 

solver from the Project Manager or the AiQuipment menu. In the third step, the 

slope calculation method is defined, as described below. 
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Step 3 – Aspect settings 

Aspect calculation – a dropdown list specifying what type of 

calculation will be used to define aspect.  Two different calculations 

are provided Degrees and Radians. 

Output information – this area provides some general statistics about 

the resulting grid surface such as the grid extents and the dimensions. 

Actions – These are standard settings that help you move through the 

wizard, open and close the Preview window and apply changes to it. 

 

 

The Aspect solver has also been included in the Grid-to-Grid wizard.  The main 

benefit to using the Grid-to-Grid wizard is that it allows you to perform the analysis 

within masked area.  In other words it allows you to choose a rectangular area 

upon which the Aspect calculation will be performed. 
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Viewshed Analysis 

A Viewshed analysis helps you to understand the relationship between visibility 

and terrain variability in an area surrounding one or more observation points. 

Essentially, Geomatica LidarEngine evaluates all grid cells surrounding a viewing 

location and evaluates whether they are visually connected.  Many variables are 

considered in the calculation, including the elevation of the observation point 

above the surface, as well as the curvature of the Earth. 

 

  

Elevation grid with five transmitter 

locations 

 Resulting thematic grid that is classified with 

respect to the probability of visibility. 

 

This type of analysis is used in many applications.  For example you can determine 

the visual exposure that a billboard receives from an adjacent highway.  When 

considering what parts of a forest are to be logged you can exclude areas that 

are visually connected to hiking trails, roadways, lakes and camp sites. A 

telecommunication company can identify potential new tower locations, by 

determining what areas are visually connected to the existing network. 

 

In Geomatica LidarEngine the Viewshed Analysis solver produces two main 

outputs.  The first is a thematic grid where each cell has been classified with 

respect the probability that it is visually connected to an observation point.  The 

second output is another thematic grid, this one is classified with respect to how 

many observation points are connected to each cell.  If the observation points 

are manually entered into the wizard then these are save to a separate file.  

When entering observation points you have the option to set the height a viewing 

radius of each location. 
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Using Viewshed Analysis 

The Viewshed solver is a three or four step wizard depending on, from where it is 

launched.  It can be launched from any of the following locations, the 

AiQuipment menu in the main application window, the right click Solver menu in 

the Project Manager, or from the Workbench panel window. 

In the first step of the wizard, you will identify the name and location of the folder 

where the results will be stored.  In the second step, you will choose from the 

project on which grid to run the procedure.  This step is skipped if you launch the 

solver from the Project Manager or the AiQuipment menu.  In the third step, the 

slope calculation method is defined, as described below. 

 

Step 3 – Insert transmitters 

In Step 3, the location of each transmitter or observation point is 

defined.  This can be accomplished by either manually entering the 

locations into the Preview window or identifying a map layer in the 

project that already contains the transmitter locations. 

 

 

 

 

 

 

 

 

 

 

 

 

 

To manually add a new transmitter, select the Add Point button 

located on the left side of the Preview window and then click on the 

map.  With each click a triangular symbol will appear marking the 

location.   

Choose an existing 

transmitter file by 

clicking here. 

Insert a new 

transmitter by using 

the Add Point tool.  

Transmitter table  

Manually enter 

coordinates for a 

new transmitter.  
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If more precision is required then the coordinates of the transmitter 

can be entered in the lower portion of the dialog. Simply enter the x 

and y-coordinates for the transmitter, along with the height and 

viewing radius.  Once this information is entered click the Add 

Transmitter button and the new transmitter will appear on the map 

and in the table. 

In some situations a transmitter file may already exist.  In this instance 

the file can be loaded into the solver avoiding having to recreate the 

transmitter parameters. 

 

Specify transmitter file name – If a transmitter file already exists it can 

be loaded into the solver by selecting the button with the ellipses on it 

(…). 

Transmitter table – this table displays a listing of all of the transmitters 

that will be used in the analysis.  It displays the x and y-coordinate, the 

height, and viewing radius parameters for each transmitter.  These 

parameters can be edited by clicking inside any of the fields in the 

table. 

X coord – an edit box where the x-coordinate of a new transmitter is 

entered. 

Y coord – an edit box where the y-coordinate of a new transmitter is 

entered. 

Height – an edit box where the height of a new transmitter is entered. 

Radius – an edit box where the viewing radius for a new transmitter is 

entered. 

Add Transmitter – a button that inserts the new transmitter into the 

map and the transmitter table. 

 

Step 4 – Results 

The final step displays the results of the Viewshed analysis.  The main 

result is a thematic grid that has been classified with respect to the 

probability of being visually connected to any of the observation 

points. 
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Results Layers – a drop down box that list the two output files 

produced by the Viewshed Analysis.  The chosen map layer will be 

displayed in the Preview window. 

Specify transmitter file – specifies the name of the file in which the 

observations points will be saved.  The height and viewing radius 

settings are also saved to this file. 

Open results – Specifies that the results should be opened into a map 

window once the analysis is complete. 

 

Effective Transmitters 

The effective transmitter grid is a thematic grid that identifies how 

many transmitters or observation points are visually connected to 

each cell. 

 

 

 

 

 

 

 

Drop down lists the different 

output files that can be 

viewed in the Preview 

window. 

Enter the name of the 

file that will contain 

the observation points 

Opens the results  
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Terrain Variability 

The Terrain Variability solver calculates the volume of material needed to be 

moved in order to make a user defined area flat.  The solver assumes that no 

additional material will be added or removed from this area. 

This type of analysis is quite valuable for those in businesses that are connected to 

the shaping of the Earth’s surface such as builders, landscape specialist, and 

environmental workers, as it allows them to more effectively plan, deploy and 

budget resources.  For example when determining the best location for a road 

way, landfill site, or even a football field, the flatter the surface is to begin with the 

less effort and cost involved to prepare it for construction.   

Traditionally this type of analysis utilized a number of techniques for analyzing 

terrain such as slope, aspect and even watershed areas.  The problem with these 

is they only characterize the terrain at a specific point and not for an area.  In 

addition, they only provide insight to how much effort is required for leveling the 

terrain without properly quantifying it. 

Shown below are the results from a slope and terrain variability analysis 

performed on a specified grid of elevation.  As you can see, in either case, it is 

fairly easy to identify the flat areas.  If you are only trying to identify where the flat 

areas are, then performing a slope analysis is all you have to do.  If you wish to 

quantify the effort required to make an area flat, then the Terrain Variability grid is 

better suited, as its output can be directly related to cost. 

 

         

Slope grid derived from elevation.  Terrain variability grid as derived from 

elevation. 
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Results are expressed in cubic meters.  If the elevation grid is in a projection 

system that utilizes latitude and longitude as the coordinate units, then a 

conversion is made to linear plane units in order to obtain accurate volumes. 

 

Using Terrain Variability 

Terrain Variability is a two step wizard which does not provide a preview window 

for the results. The solver can be accessed from either the AiQuipment menu in 

the main application window, the right click Solver menu in the Project Manager, 

or from the Workbench panel window. 

In the first step you will identify the name and location of the folder where the 

results will be stored when processing is complete. In the second step you will be 

provided settings that directly affect the interpolated results.  These settings are 

described below.  This solver is always run on the active map layer in the Layer 

List. 

 

Step 2 – Terrain Variability settings 

Estimated radius of zone – is the radius of the 

area about each grid cell that will be used to 

calculate the volume of material that needs 

to move in order to achieve flat terrain. 

 

Output information – this area provides some 

general statistics about the resulting grid 

surface such as the grid extents and the 

dimensions. 

 

Actions – These are standard settings that help 

you move through the wizard, open and close 

the Preview window and apply changes to it. 

 

The Terrain Variability solver has also been included in the Grid-to-Grid wizard.  

The main benefit to using the Grid-to-Grid wizard is that it allows you to perform 

the analysis within masked area.  In other words it allows you to choose a 

rectangular area upon which the Terrain Variability calculation will be performed.  

In addition it also provides a preview window of the results. 
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Map Projections 

An integral part of any digital or paper map is its projection.  It solves a 

fundamental problem with representing things or objects found on the Earth’s 

surface such as roads and political boundaries, and portraying them accurately 

on a flat surface like a paper map or computer screen.  It does this by using a 

mathematical formula that estimates the spheroid shape of the earth when 

transforming the position of things from the real world to the flat surface.   

 

The projection defines many characteristics of a map such as distances, 

elevations, the shape and area of regions, and even direction i.e. which way is 

North.  Due to the complexity of the transformation problem it is impossible to 

accurately portray all of these elements without distortions.  This is why there are 

many different types of projections each one specifically designed to portray 

information in a certain way. If you would like to have a better understanding of 

projections please refer to the references at the end of this section. 

 

Although the topic of projection is quite complex Geomatica LidarEngine has 

made it easy for new and experienced users of GIS.  For new users Geomatica 

LidarEngine employs an On-the-Fly projection feature that eliminates the need for 

manually transforming all map layers to the same projection system prior to 

viewing them together, Geomatica LidarEngine automatically performs the 

transformation in real time.  For experienced users the Reproject dialog provides 

them the ability to make simple modifications to existing projection or to create 

entirely new ones by just making selections from drop down lists and entering 

values.  

 

Reproject dialog 

The purpose for the Reproject dialog is to display the projection and coordinate 

system of the selected map layer.  In addition, it also provides a means of 

modifying these parameters.  This dialog can be accessed from three different 

locations, from the Properties dialog, the Project Manager right click menu, and 

the Map toolbar located in the map window. 

 

When accessed from the Properties dialog the projection and coordinate systems 

are for display only and modifications are not permitted.  The Properties dialog is 

accessed by first selecting the map layer from the Project Manager, clicking the 

right mouse button, and then selecting the Properties menu item. 
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When accessed from the Project Manager right click menu (Reproject menu 

item) the dialog is fully functional.  Modifications can be made to parameters for 

both projection and coordinate system.  Any modifications will be applied to the 

map layer selected in the Project Manager. 

 

When accessed from the Map toolbar the 

dialog is fully functional as indicated above 

however modifications are only made to the 

display of the map layers within that window.  

This utilizes the On-the-Fly projection feature 

that calculates the proper transformation for 

each layer displayed in the window.  

Modifications made in this manner are purely 

visual and apply only to that map window.  

Increase in window refresh rates can be 

expected as extra time is required to perform 

the transformation calculations. 

 

The Reproject dialog is divided into two 

sections.  The top section displays the current 

projection settings for the selected map layer 

and bottom section displays the coordinate 

system.  For both sections a series of 

command buttons are available for making 

modifications, they are Select, Modify, New 

and None.  Listed below is a generalized 

description of each of these buttons. 

 

Select – a command button that opens the Select 

Projection/Coordinate System dialog.  From this dialog the 

projection/coordinate systems can be defined. 

 

Modify – a command button that opens the Modify 

Projection/Coordinate System dialog.  From this dialog changes can 

be made to specific parameters of the current projections or 

coordinate system.  Please see the appropriate section on Modifying 

/ Creating for details. 
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New – a command button that opens the Modify 

Projection/Coordinate System dialog from which a new custom 

projection can be created.  Please see the appropriate section on 

Modifying / Creating for details. 

 

None – a command button that removes the current projection 

coordinate system and applies an unprojected latitude and 

longitude coordinate system.  When the None button is selected for 

the projection section then the description will be displayed as 

Geographic.  When the None button is selected for the coordinate 

system section then the description will displayed as Undefined.  

 

 

 

Selecting the Projection 

When the Select command button is chosen from the projection section of the 

Reproject dialog then the Select Projection dialog appears.  This dialog contains 

a tree view listing of several hundred standard projection systems used around 

the World.  They have been organized into categories to make the one you are 

looking for easier to find. To select a projection simply expand the desired 

category and highlight the projection system of choice.  Once selected the OK 

button will become available.  Because each standard projections system 

already has a predefined coordinate system, the new coordinate system will be 

automatically applied. 
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Modifying / Creating a Projection 

The same Projection System dialog is used when 

either modifying the parameters of the current 

projection system or creating a new one.  When 

the Modify button is selected then the dialog is 

populated with the parameters specific to the 

chosen projections system.  When the New button 

is selected then the dialog is left unpopulated 

however the parameters displayed will reflect 

those of the previous projection. 

 

Depending on the projection system chosen 

different parameters will be required.  Below is a 

description of those parameters that are utilized 

most often. 

 

 

 

Name – an edit box displaying the name of the projection.  This name is only 

cosmetic and does not affect projection parameters.  If the map layer was 

imported from a format where the projection information was known then this is 

reflected in the name.  This is typical of map layers originating in the MapInfo 

Professional spatial data format. 

Projection Name – a drop down listing of all available projection types. 

Central Meridian – defines the location of the origin for the x-coordinates and 

specified in degrees. 

Latitude of Origin – defines the location of the origin of the y-coordinates and 

specified in degrees. 

Standard Parallel l – defines a line of latitude where the scale is 1 (distortion = 0).  

Only available for Conic projections and is specified in degrees. 

Standard Parallel 2 – defines a line of latitude where the scale is 1 (distortion = 0).  

Only available for Conic projections and is specified in degrees. 

Scale Factor – a value applied to the center point or line of a map projection. 

False Easting – defines the artificial shift in the x-coordinate value of the origin.   

Typically used in UTM projections so that all coordinate values are positive. 
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False Northing – defines the artificial shift in the y-coordinate value of the origin.   

Typically used in UTM projections so that all coordinate values are positive. 

Linear Unit Name – a drop down list of the available units’ types.  If a custom type 

is chosen then a scaling factor defining how many meters are in each custom 

unit.  This value is entered into the Meters per unit edit box. 

Selecting the Coordinate System 

When the Select command button is chosen from the coordinate system section 

of the Reproject dialog then the Select Coordinate System dialog appears.  This 

dialog contains a listing of several hundred standard coordinate systems used 

around the World.  The list has been gathered from two different sources which is 

evident by the capitalization of the coordinate system names.  Be sure to inspect 

the entire list when trying to find the desire coordinate system. 

 

 

 

Modifying / Creating a Coordinate System 

The same Coordinate System dialog is used when either 

modifying the parameters of the current coordinate 

system or creating a new one.  When the Modify button 

is selected the dialog is populated with the parameters 

specific to the chosen projections system.  When the 

New button is selected then the dialog is left 

unpopulated allowing for a custom coordinate system 

to be created.  The following is a description of each 

parameter found on the Coordinate System dialog. 
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Name – an edit box for the name of the coordinate system.  It is this name that 

will appear in the Select Coordinate System dialog. 

 

Datum Name – a drop down list of all the available datum types. 

 

Spheroid Name – a drop down list of all available spheroid types.  This setting is 

only available when the Custom datum type is selected. 

 

Semimajor axis – an edit box that defines the semi-major axis of the spheroid.  This 

setting is only available when the Custom spheroid type is selected. 

 

Semiminor axis – an edit box that defines the semi-minor axis of the spheroid. This 

setting is only available when the Custom spheroid type is selected. 

 

Inverse Flattening – an edit box that defines the difference in length between the 

semi-major and semi-minor axis.  The larger this value the more spherical the 

spheroid becomes.  This setting is only available when the Custom spheroid type 

is selected. 

 

Molodensky transformation – a series of three edit boxes for each parameter 

required by the Molodensky transformation method, Delta X, Delta Y, and Delta Z. 

This setting is only available when the Custom spheroid type is selected. 

 

Angular Unit Name – a drop down list of all of the angular units available. 

 

Radians per unit – an edit box defining the number of radians per unit measure.  

This setting is only available when the Custom angular unit type is selected. 

 

Prime Meridian Name – a drop down list of all available prime meridians. 

 

Longitude – an edit box defining the desired degree of longitude that will be used 

for the prime meridian. This setting is only available when the Custom prime 

meridian type is selected. 
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On-the-Fly Projections 

In many conventional GIS systems there is a requirement that all maps within a 

project, or at least those to viewed together in the same map window, must be in 

the same projection system.  This often meant that users had to manually change 

some or all of their map layers to meet this requirement.  In Geomatica 

LidarEngine this requirement has been eliminated with the On-the-Fly Projection 

feature.  This feature automatically performs the necessary transformations in real 

time when to map layers of disparate projections are placed into the same map 

window.  A unique feature to Geomatica LidarEngine is its ability to apply this 

functionality to both vector and raster data structures. 

 

The On-the-Fly Projection feature is encountered in two situations.  The first is when 

the user chooses to display two or more maps of different projection systems in 

the same map window.  Geomatica LidarEngine chooses the projection of one 

of these layers to be static and transforms the others to match it.  Generally it is 

the first map to be displayed in the window that retains the projection type.  With 

this situation the transformations are transparent to the user as there is no 

notification that one has taken place.   

 

The second situation occurs when the user consciously modifies the projection of 

the map window.  This is done by selecting the Set Window Projection located on 

the Map toolbar. 

 

It should be noted that when ever there is a need to perform an On-the-Fly 

projection change refresh times for the map window will increase due to extra 

time required to perform the necessary transformations.  If refresh times become 

unmanageable then the solution is to manually transform some or all map layers 

to the same projection system. 

 

Applying Modifications 

If any changes have been made to either projection or coordinate systems then 

a dialog will appear prompting you to how the changes are to be applied.  Three 

options are provided reproject, reassign and do nothing. These are described 

below. 

 

Reproject – a radio button specifying that a transformation will be 

performed on the selected map layer converting it from its current 
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projection to the new one.  When selected a new map layer is 

generated and placed in the Analysis folder.  

Reassign – a radio button specifying that the projection system for the 

current map layer will be reassigned to the new one.  No 

transformations are performed with this option and no additional map 

layers are created.  

Do Nothing – nothing is done and the operation is cancelled. 
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